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Conventions and Operating Instructions

1 Conventions and Operating Instructions

Target audience and qualifications

This Administrator and User Manual is written for service staff members in charge of the basic con-
figuration and commissioning of DPS-view. It also provides support for all users and operators
who work with DPS-view on an everyday or regular basis.

To carry out the operations described in this document you need to be familiar with Windows and
have a good understanding of the basic laws and principles of telecommmunications engineering.
Also, all service staff members should be familiar with the handsets and terminals that are em-

ployed and the functions of their PBX.

Contents

This chapter covers the following areas:

1.1
1.2
1.3
14
1.5
1.6

Overview of the chapters in this document
Reference manuals

Notations and symbols

General instructions

Symbols used to classify potential causes of danger
Privacy and data security
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Conventions and Operating Instructions

Overview of the chapters in this document

1.1

1.2

1-2

Overview of the chapters in this document

This manual also contains the following chapters:

Chapter

Summary

Chapter 2, "Overview"

This chapter provides an overview of the various functions
and properties of DPS-view. It also covers the system require-
ments and the central positioning interface of DAKS-Position-
ing Services (DPS).

Chapter 3, "Install and Uninstall
DPS-view and Migrate Data
Structures"

This chapter shows you how to install DPS-view, how to re-
move it again from your PC and how to migrate data struc-
tures of n already existing and installed DPS-view versions. It
also covers the example files that are included ex-works in ev-
ery DPS-view delivery and explains the hierarchical DPS-view
data structure that also serve as a basis for your further ad-
ministration.

Chapter 4, "The Administrator
Tool DPS-view-Edit"

This chapter covers the DPS-view-Edit administrator tool that
serves all local settings. It shows you how the visualization of
the obtained positioning results is simulated and introduces
you to the predefined visualization templates, including their
default settings. Also, this chapter shows you how to create
and edit your own customized visualization templates for the
positioning processes you need to carry out, and work with
Levels, Objects and Polygons.

Chapter 5, "The Server Applica-
tion DPS-view"

This chapter covers the functions of the server application
DPS-view, including the settings and the logging of the posi-
tioning processes in the lodfile and in the window of the appli-
cation.

Chapter 6, "Glossary"

The Glossary lists and explains in alphabetical order the tech-
nical terms that are found in this document.

Table 1-1 Overview of chapters

Reference manuals

The below-listed documents can be of additional help when working with DPS-view and this doc-

ument:
e  (OScAR-Pro User Manual

e  (OScAR-Pro Installation Manual
e OScAR-Pro Server Configuration Manual

P31003-S1750-M103-01-76A9, 08/2021
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Conventions and Operating Instructions

Notations and symbols

1.3 Notations and symbols

Conventions

The following definitions are used in this Administrator and User Manual:

Text

All texts copied from files that are described in this document and
all entries that are made in the application are shown in the mono-
space font Courier.

The password 123456 ...

Details and instructions in the continuous text that are of particular
importance or must be heeded are output in bold print. Buttons
are also in bold print.

The file global.cfg

Files and directories are output in the monospace font Courier.

" Namen

Field names, menu names and window descriptions are placed in
"quotation marks".

<Place holder>

Entries and outputs, both of which may vary depending on the indi-
vidual situation in which they appear, are placed in <angle brack-
ets> and are in italics.

Table 1-2 Notations

Symbols

The following symbols are used in this Administrator and User Manual:

Note:

Caution!

> ©

with particular caution.

P31003-S1750-M103-01-76A9, 08/2021
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The exclamation mark is used to indicate important information which the reader should treat
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Conventions and Operating Instructions

General instructions

1.4

1.5

1.6

1-4

General instructions

Operations on the OScAR server and the PBX

Please bear in mind that operations performed on the OScAR server may only be carried out by
qualified service staff. These operations are mainly covered in the OScAR-Pro Server Configura-
tion Manual, and are not further described in this document.

Symbols used to classify potential causes of danger

The below-listed symbols can be found on devices to warn operators of potential risks and dan-
gers. They are, however, not normally used in this document.

A A A A i
High Heavy High Chemical Electrostatic ~ Risk of

) Flammable sensitive laser
tension load temperature substances o o
device radiation

* electrostatic discharge damage

Privacy and data security

This system processes and uses, among other things, personal data, e.g. for billing purposes, dis-
play outputs and to create subscriber data.

In Germany, the processing and application of use of such personal data is subject to various reg-
ulations, including the Federal Data Protection Act (Bundesdatenschutzgesetzes, BDSG). Be
careful to follow the laws and regulations for the protection of personal data that are in force in the
country in which you work.

The purpose of data protection is to protect the individual against any infringement of his or her
personal rights through the misuse of personal data.

In addition, the goal of the data Protection Regulations is the safeguard of the data from misuse
during the different processing phases and consequently to counter any impairment caused to ex-
ternal or internal legitimate interests.

Please help ensure complete data protection and data security by being aware of these is-
sues as you work:

e Always make sure that only authorized persons have access to personal data.

e  Assign passwords whenever you can. Do not grant unauthorized persons access to your
passwords, for example by writing them down.

e  Always make sure that no unauthorized persons can process or utilize personal data in any
way, for example by saving, communicating, blocking or deleting this information.

e Always make sure that no unauthorized persons have access to data storage media, for ex-
ample to backup disks or printouts of logfiles or reports. This applies both to service work
provided directly at the customer and to the storage and transport of data carriers.

e Always make sure that every data storage medium that is no longer needed is properly and

fully destroyed. Also be careful not to leave behind any papers that could become openly ac-
cessible to others.

P31003-S1750-M103-01-76A9, 08/2021
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Overview

Overview

This chapter provides an overview of the various functions and properties of DPS-view. It also cov-
ers the system requirements and the central positioning interface of OScAR-Positioning Services

(DPS).

Contents

This chapter covers the following areas:

2.1

2.2

2.3
2.4
2.5

Introduction and functionality

211 System requirements
21.2 Components
21.3 Visualization of objects

21.4 Applied maps

Positioning in DECT and WLAN infrastructures

2.2.1 Positioning Accuracy Level when positioning devices
DAKS Positioning Services (DPS)

System requirements

Information and error reports

251 Information when positioning results are obsolete
252 Information when visual output is not possible
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Overview

Introduction and functionality

2.1

211

21.2

2-2

Introduction and functionality

In connection with the operation of the OScAR Positioning Services (DPS) to locate DECT hand-
sets or WLAN capable communication devices in order to provide protection of employees and
staff members, we are increasingly witnessing the need to also visualize the exact location of an
alerting or distressed person in a format that is clear-cut, straightforward and easy to read. In this
context it is especially important to structure the graphic output in such a way that also untrained
staff can spot an alerting person quickly and as reliably.

DPS-view is a supplementary component of OScAR’-Pro and visualizes the location tracking re-
sults in DECT and wireless LAN infrastructures. DPS-view visualizes the location tracking results
that are otherwise only output as a voice message or display text directly at the communication
device or handset.

Fro more information on the OScAR-Positioning-Services:
» see OScAR-Pro User Manual

System requirements
The following systems must be installed to work with DPS-view:

OScAR-Pro with the application OScAR-Positioning-Services (DPS)
» see Section 2.3 "DAKS Positioning Services (DPS)"

Components
DPS-view consists of the following components:

e The server application: DPS-view

The server application DPS-view represents the operative part of the visualization system. It
accepts visualization requests, builds the maps with the superimposed objects, and provides
the computed results in form of HTML pages for output in the OScAR-TT Operator-Tool.

» see Chapter 5, "The Server Application DPS-view"
e The administrator tool: DPS-view-Edit

The administrator tool DPS-view-Edit is used to create and administrate the data structure
for DPS-view. DPS-view-Edit is a graphic tool that serves to load the different maps, but also
to superimpose and edit the objects thereon.

OScAR-Positioning-Services (DPS) offers functions to export the data of objects (BS, AP,
AQI). This ensures that no double data maintenance is required. When the data of objects
is changes in the database of OScAR-Positioning-Services (DPS), you can export the new
object data in form of a text file for import into an already existing project in DPS-view-Edit.
» see Section 4.6.2.1 "Import object list from a text file"

Visualization of objects

The visual rendition of location tracking results in DPS-view is achieved via OScAR-TT Operator-
Tool in hierarchically structured graphics. These graphics consist of maps upon which the re-
ceived objects are output, namely:

e Base Stations or Access Points

Output in form of symbols representing the object. The size and color of the symbols vary
depending on the field strength with which they are received.

e Areas of Interest

Output in form of polygons that cover the area where the device is most likely located at pres-
ent. The color of the polygons varies depending on the quality of the positioning process,
which enables a clear and easy-to-grasp presentation of the positioning results.

» see Image 2-2  DPS-view visualization of positioning results in DAKS-TT Operator-Tool

P31003-S1750-M103-01-76A9, 08/2021
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Introduction and functionality

With its user-friendly and intuitive operation, DPS-view makes it possible to navigate easily be-
tween the different maps. This enables the user to open, for example, an exploded view of a lower
map-level simply by directly clicking the wanted object.

As the visualization is structured in different hierarchy levels, the individual map-levels can easily
be reached at any time at the click of the mouse.

DPS-view is very user-friendly and easy to install. The system configuration and administration is
via the graphic administrator tool DSP-view-Edit.
» see Chapter 4, "The Administrator Tool DPS-view-Edit"

In addition, DPS-view enables you to freely parameterize the graphic rendition of your objects us-
ing so-called predefined visualization templates. This option makes it possible to customize the
way in which your location tracking results are output to the specific needs and requirements of
your business.

» see Section 4.3 "DPS-view-Edit visualization templates'

214 Applied maps

DPS-view operates with maps (any) in the JPEG format, for example with:

e  structural plans (e.g. architectural drawings, site plans)

e Exploded views and isometric data (3D views)

e Aerial views (e.g. aerial view of your company site/premises)

e  Sketches (e.g. hand-drawn sketches and abstract drawings of buildings)

The below screen shot shows the exemplary positioning results when based on the iso-
metric presentation of a company site:

5 Title

Crtumg Femser bty

top floor

If needed,
error msg.

3" floor

2" floor

1 floor

sl Area of
[ Interest

underground
garage

Received
Base Statior

Right
navigation
bar

Map with placed objects Lower navigation bar

Image 2-1  DPS-view - Isometric presentation of company site (example)

The visualization of positioning findings in DPS-view consists of these components:

e (Caption above the positioning findings shown in DPS-view

The title consists of: "DPS-view Positioning - Name: <name of subscriber>, Number: <phone
number of communication device>, Map: <name of map>"

e Map with placed objects (details)

P31003-S1750-M103-01-76A9, 08/2021 2-3
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Positioning in DECT and WLAN infrastructures

The map shows the following objects depending on their received standardized field
strength:
—  Areaof Interest (AOI)

The size and the color of the symbols varies depending on their received field strength.

— Received Base Station (BS) or Access Point (AP)
Visualized in form of symbols that show the respective objects depending on their re-
ceived standardized field strength.

¢ Right navigation bar
This area contains the navigation buttons to jump to the next maps.
e | ower navigation bar

Use these two buttons to navigate to the main view (Overview) or jump back to the last map
(Back).

e Where needed, error message
» see Section 2.5 "Information and error reports’

2.2 Positioning in DECT and WLAN infrastructures

The prerequisite for any positioning of a communication device to be carried out in DECT or wire-
less LAN networks is a positioning request that must be addressed to the handset. There are sev-
eral categories of handsets:
e DECT handsets with full positioning capability:

Positioning details: Visited Station and field strength table

Communication devices OpenScape DECT-Phone S5,
OpenScape DECT-Phone SL5,
OpenScape M3
e Communication devices with limited positioning capability:

Positioning details: Visited Station

Communication devices: Any DECT handsets that has no full positioning capability
e  WLAN communication devices:

Positioning details: Field strength table

Communication devices: OpenScape WL3, Ekahau Tag

The location tracking results are composed of the following elements:

e Visited Station

This is the Base Station through which the communication device you want to locate is cur-
rently communicating. This station is the so-called "Visited Station".

e Field strength table
This table lists the field strength values of the Base Stations (for DECT networks) as well as
the field strength values of the Access Points (for wireless LAN networks), which the DECT
or WLAN communication device is currently receiving in its physical surrounding.

2-4 P31003-S1750-M103-01-76A9, 08/2021
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OScAR Positioning Services (DPS)

2.2.1 Positioning Accuracy Level when positioning devices
The positioning is carried out in three levels of accuracy with the obtained results output in form
of a voice message or a display text message, or in form of a graphic visualization of the computed
location details:
e Positioning Accuracy Level 1 - Lowest degree of accuracy (only for DECT):
—  Voice/Display text message: Output of the Visited Station
—  Visualization: Output of the Visited Station in DPS-view
e Positioning Accuracy Level 2 - Medium degree of accuracy (for DECT and WLAN):

—  Voice/Display text message: Output of the Base Stations or Access Points that are re-
ceived the strongest in the surrounding of the wanted communication device, with clas-
sification of the field strength. This process does not include an interpreting of the ob-
tained results; the measured results are processed and presented to the alerted user in
an easy-to-read and straightforward format.

—  Visualization: Output of the received Base Stations or Access Points in DPS-view. Both
the color and the size of the received Base Stations or Access Points vary depending
on their received field strength.

e Positioning Accuracy Level 3 - Highest degree of accuracy (for DECT and WLAN):

—  Voice/Text message: Both HPS and EPE compute the most probable location or Area
of Interest (AOI) for the wanted terminal. This is done on the basis of the field strengths
of the Base Stations or Access Points that are presently being received by the device
in its physical surroundings, and by using reference measuring and calibrated maps.
The results of this process are transmitted as in form of a voice message or display text
message.

—  Visualization: The graphic output of the wanted device's most probable location, output
in form of a circle superimposed on a calibrated map by the SPS Locator, or else in form
of a colored polygon in DPS-view.

2.3 OScAR Positioning Services (DPS)
OScAR-Positioning-Services (DPS) is the central positioning interface of OScAR-Pro and inte-
grates the positioning servers HiPath-Positioning-Server (HPS) and Ekahau-Positioning-Engine
(EPE). The positioning capability provided by OScAR-Positioning-Services itself is without inter-
pretation of the obtained positioning results (positioning accuracy levels 1 and 2).
Also, DPS can assess the threshold values of the field strength received by the Base Stations and
in this way match them to the equivalent Areas of Interest (AOIs), i.e. to the the most probably
area in which the wanted device is currently located.
Via DPS-view, OScAR Positioning Services (DPS) can visualize both Areas of Interests as well as
Base Stations and Access Points as the obtained results of a positioning process.
The positioning results are shown in the OScAR-TT Operator-Tool in an own window.
P31003-S1750-M103-01-76A9, 08/2021 2-5
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OScAR Positioning Services (DPS)

‘D Applikation Operationen Datei  Ortung  Fenster  Hilfe

B 2

top floor

Details

1st floor

3" floor

underground garage

2" floor ¥, L AL
Sisited o 7 L 7T

3rd floor

1% floor

top floor

underground
garage

Image 2-2  DPS-view visualization of positioning results in OScAR-TT Operator-Tool
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System requirements

2.4 System requirements

e For server application DPS-view: Windows PC (Windows 10, Windows Server 2016/2019)
e  For administrator tool DPS-view-Edit: Windows PC (Windows 10, Windows Server 2016/

2019)
e For output positioning results in OScAR-Positioning-Services (DPS): OScAR-TT Operator-
Tool
2.5 Information and error reports

In the event of an error, DPS-view outputs helpful additional details above the map, e.g. when OS-
cAR Positioning Services (DPS) receives a Base Station in the field strength table that has not yet
been administrated in DPS, or a valuable indication when the obtained positioning results are ob-
solete.

2.5.1 Information when positioning results are obsolete

When DPS-view detects that the positioning results have already become obsolete, it places a
helpful warning right above the map, for example:

DPS-view Locating - Name: Holger Sommerfeld, Number: 474, Map: Silberbachstrafe

top floor

3" floor

2" floor

1* floor

underground
parking

Eoe CECTT s

Image 2-3  Information when results are obsolete (not locatable for technical reasons)
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Information and error reports

2.5.2 Information when visual output is not possible

If the application is unable to visualize the positioning results, it sends a corresponding error mes-
sage.
Device not locatable

The below image shows shows the error message that is sent by DPS-view when a communica-
tion device cannot be located for technical reasons. Here, the number of the device that could not

be positioned is shown in brackets.

DPS-view Locating - Name: Holger Sommerfeld, Number: 474, Map: Silberbachstralle

Image 2-4  Error message when device cannot be located (positioning error)

P31003-S1750-M103-01-76A9, 08/2021
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Install and Uninstall DPS-view and Migrate Data Structures

3 Install and Uninstall DPS-view and Migrate Data
Structures

Overview

This chapter shows you how to install DPS-view, how to remove it again from your PC and how
to migrate data structures of n already existing and installed DPS-view versions. It also covers the
example files that are included ex-works in every DPS-view delivery and explains the hierarchical
DPS-view data structure that also serve as a basis for your further administration.

Contents
This chapter covers the following areas:

3.1 Install DPS-view

3.2 Migrate and upload DPS-view data structures

3.3 DPS-view example file and data structure included ex-works
3.4 Uninstall DPS-view

P31003-S1750-M103-01-76A9, 08/2021 3-1
OSCcAR Positioning System-view, Administrator Manual



Install and Uninstall DPS-view and Migrate Data Structures
Install DPS-view

3.1 Install DPS-view

DPS-view can be installed in a single step process.

Note:
@ You must have administrator rights to install the DPS-view software.

To install the DPS-view software on your computer, the following requirements must be ful-
filled:

e Microsoft Windows 10, Windows Server 2016 or Windows Server 2019 is installed on your
computer.

During the installation process, the following components are installed on your computer:
e  Server application DPS-view

e Administrator tool DPS-view-Edit

e  Example files with data structure

Note:

Follow the system instructions that are output to you during the installation. Click Back if you
want to return to a previous window, for example to add changes. If you want to abort and not
complete the installation, click Cancel.

Caution!

It is strongly recommended that you install DPS-view server application as a service (Server ser-
vice).

> ©

Proceed as follows to install DPS-view on your computer:

No. Task Window
1. | Place the Installation CD in the CD-ROM
drive. Run 21
If the installation software fails to start auto-

i Type the name of a program, folder, document, or

ma’[ica”y’ p|ease start the CD installation man- : Internet resource, and Windows will oper it For you,
ually from the Windows interface with the
command Run menu....

To do so, enter the following command in the e
command bar and click OK: - conce trowse._|

e <CD-Rom drive>:\cdsetup,
€.g.. d:\cdsetup.

QOpen: | d:edsetup| j

2. | Now click the menu item:

e "Install the Positioning Tool "DPS-view -
V2. xx"" I’ tetronik GmbH
@
i
Table 3-1 Install DPS-view
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Install DPS-view

No.

Task

Window

3.

Select the language you want to use and con-
firm with OK.

Choose Setup Language ] 1'

@ Select the language for this installation from the choices below.

Cancel |

The installation is now initialized.

P St & e Bt Wicwd, which ol
¥ puide s g e poggam s process. Piewe et

Corfigang Widows Futales

Click on Next to make additional installation
settings.

i DPS-view - InstallShield Wizard

Welcome to the InstallShield Wizard for
DPS-view

The Instalishield(R) Wizard will install DPS-view on your
computer. To continue, click Kext.

WARNING: This program is protected by copyright law and
international kreaties.

I Mext = I

<Back cancel |

Enter the user name and the name of the or-
ganization or company.

Specify if you want the software to be installed
for all users of this PC, or only for you.

Now click Next.

{6 DPS-view - Installshield Wizard

Customer Information

Please enter your information.

User Kams:
[My Name:

Organization:

[My Orgarization

Install this application for:

% Anyone who uses this computer (all users)

" Only for me (Tetranik GmbH AEN)

InstallShisld

I Mext = I

<Back Cancel |

Table 3-1

Install DPS-view
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Install DPS-view

No. Task Window

7. | To change the installation path, click the but- | sy

: x|
ton Change... and enter the new path in the e e -
WindOW that pOpS Up next' Click Mext to install ko this Folder, or dick Change to install to a different folder, ,

Click Next. Install DPS-view to
“

< Back, I ext > Cancel

8. |Click Install to install DPS-view on your PC.

|§ DPS-view - InstallShield Wizard x|
Ready to Install the Program b -
The wizard is ready to begin installation, . Ir

Click Install to begin the inskallation,

If you want ko review or change any of your installation settings, dick Back, Click Cancel to
it the wizard.

Trstlshisld
< Back I Install I Cancel
9. | The software is now installed in the selected
. [ DPS-view - InstallShield Wizard N =10 x|

dl re Ctory . . . . Installing DPS-view o

The progress of the installation is shown with The pragram features you selected are being installed. N II'

a blue progress bar. @ Pl ket Il iard st FS-vow, T may toke

several minutes,

Status:

Insta(Shisld

= Baclc Ijext > | Cancel I

10. | Click Finish to complete the installation.
After the installation is completed, the Win-
dows Program Manager, and there the pro-
gram group "tetronik OScAR-TT" will list the
program icon for:

e  DPS-view, DAKS V9.x.

{& DPS-view - Installshield Wizard x|

Installshield Wizard Completed

The InstaliShield Wizard has successfully installed DPS-view,
Click.Finish ko exit the wizard.

= Back I Finish I Cance]

Table 3-1 Install DPS-view
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Install DPS-view

No.

Task

Window

1.

This will open the window "Settings" of the
server application DPS-view ("DPS-view Set-
tings").

Now, go to the window area "Server service"
and click Install, to install DPS-view as a ser-
vice.

» see Section 5.3 "Configuration of the
server application via DPS-view-Config"

Table 3-1 Install DPS-view
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Migrate and upload DPS-view data structures

3.2 Migrate and upload DPS-view data structures

Already existing DPS-view V1.xx data structures and projects can be migrated to the latest ver-
sion.

Proceed as follows to migrate data structures and projects:

No. Task Window

1. | Open the function "Migrate" through the
menu:

e Project 2 Migrate...
or apply the hotkey:

. CTRL + M

2. | Select the path you want to use.

The software will automatically migrate and - Ldi U
load the data. Select path:
During this process, the old DPS-view is re- (=) e Local Disk (C:) |
tained and will not be automatically overwrit- | | - Documents and Settings
| [#-{_3) Program Files
ten. E-) tetronik
The new structure will only be written to the i j gl
hard disc when the current project is saved. - . @ Edtor
i B-{3) Server
) Log
5 F4=h ewmrkeiark I _)lj
OK | Cancel |
3. | After you completed these steps, you can fur-
ther edit the newly migrated and uploaded
project in DPS-view.
Table 3-2 Migrate already existing projects from DPS-view V1.xx
3.3 DPS-view example file and data structure included ex-works

The name of the example file included ex-works on the Installation CD reads:

e Example project: "tetronik"

The example project "tetronik" is a fully administrated DPS-view data structure with different
hierarchy levels. To load the "tetronik" project, go the menu bar, open "File" and select
Open....

» see Section 4.1.1 "The menu bar, toolbar and keyboard shortcuts"
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Uninstall DPS-view

3.4 Uninstall DPS-view
Proceed as follows to remove DPS-view again from your computer:
No. Task Window
1. | Open the Windows Control Panel. R |
"!’ Settings v B Control Panel
m = h : t}d Metwork Connections
/J et '3 Prinkers and Faxes
=] Run.. a Taskbar and Start Menu
1
| start
2. | Open Software or Programs and Features.
File Edit View Favortes Tools  Help | .:,’
J Back - -.J v ? | /‘._) Search ) Folders |'
Address Iﬁf Control Panel j Ga
nccéssihility Add Hardware add or Administrative
Options Toals
Automatic  Date and Time Displary Folder Options
Updates |
&
Install or remove programs and Windows components, v
3. |Select the entry DPS-view.
. [ — ol
Next, click Delete. E— [ wion s
4. | This will trigger the following security prompt.
Confirm with Yes. Software |
The uninstall process of DPS-view is now 0y
started \'.\/ Michken Sie DP3-view wirklich entfernen?
[ein |
5. | The DPS-view software will now be removed.
The progress of the uninstall process is indi-
cated in form of a progress bar.
Table 3-3 Uninstall DPS-view
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Uninstall DPS-view
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4 The Administrator Tool DPS-view-Edit

Overview

This chapter covers the DPS-view-Edit administrator tool that serves all local settings. It shows

you how the visualization of the obtained positioning results is simulated and introduces you to the
predefined visualization templates, including their default settings. Also, this chapter shows you

how to create and edit your own customized visualization templates for the positioning processes
you need to carry out, and work with Levels, Objects and Polygons.

Contents

The chapter covers the following areas:

41 DPS-view-Edit - Main View
411 The menu bar, toolbar and keyboard shortcuts
41.2  The Object list
4.2 Local parameters
421 Edit local parameters
422 Predefined visualization templates
423  Select alanguage
424  Grid
425 Zoom
426 Simulation of the visualization
4.3 DPS-view-Edit visualization templates
4.3.1 Predefined visualization templates - Lists
4.3.1.1 Predefined visualization templates: Fire detector
4.31.2 Predefined visualization templates: Area of Interest (AOI)
4.31.3 Predefined visualization template: DECT Base Station
4314 Predefined visualization template: WLAN Access Points.
4.3.2 Create and edit a visualization template
4.3.2.1 Visualization type "Image’
4322 Visualization type "Image list".
4323 Visualization type "Polygon"
4324 Visualization type "Color spectrum polygon"
4.3.2.5 Edit visualization template "Polygon with image"
4326 Visualization template "Polygon with list of images"
4327 Visualization template "Color spectrum polygon with image"
4328 Visualization template "Color spectrum polygon with list of images"
4.4 Default settings
4.4.1 Default settings for "Image’
442 Default settings for "Image list"
443 Default settings for a 'Polygon'
4.4.4 Default settings for "Color spectrum polygon"
4.5 Levels
4.5.1 Edit the attributes of a level
452 Add a new level
453 Delete a level
454  Copy a level
455 Cutalevel
456 Paste and insert a level
46  Objects
4.6.1 Import objects
4.6.21 Import object list from a text file
46.2.2 Import an object list from a project
4.6.3 Add new objects and edit object attributes
46.4 Delete objects
P31003-S1750-M103-01-76A9, 08/2021 4-1
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4-2

4.7

4.6.5 Place objects

4.6.5.1
46.5.2
4.6.5.3

Place objects freely on a map
Place objects in a polygon through drag&drop
Assign an object to a polygon

4.6.6  Change the order of objects (Z-Level)

Polygons

4.7 1 Add a new polygon
4.7.2 Edit polygon points

4.7.2.1
4722
4723
4724
4725
4.7.2.6

Add points to a polygon
Delete points from a polygon
Copy a polygon

Cut a polygon

Paste a polygon

Delete a polygon
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DPS-view-Edit - Main View

41 DPS-view-Edit - Main View

Note:

moment of time.

The main view of DPS-view-Edit covers these areas:

e Menu bar

» see Section 4.1.1 "The menu bar, toolbar and keyboard shortcuts"

e Toolbar

» see Section 4.1.1 "The menu bar, toolbar and keyboard shortcuts”

e Structure view

In DPS-view-Edit, there can never be more than one data structure or project open at any given

Including hierarchical order that outputs the DPS-view data structure in form of a tree view

» see Section 4.5 "Levels"
e Object list

Consisting of the Base Stations, WLAN Access Points and Areas of Interest (see )

» see Section 4.1.2 "The Object list"
e Map view

Including an image of the current level and the objects placed thereon

» see lmage 4-1

Toolbar

Map view

Structure
view

top floor

3" floor

2™ floor

List of ob-

N

1
2:E: by
20E7:08 AP AP-0S: Assembly
2E7:04 AP AP-0S: Assembly

underground
parking

Image 4-1  Main view of DPS-view-Edit (example)
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DPS-view-Edit - Main View

411 The menu bar, toolbar and keyboard shortcuts

This section covers the functions that can be accessed in DPS-view-Edit through the menu bar,
the toolbar and via hotkey.

Menu item Description

Summary of the pull-down menu "File"

New.. Creates an empty project with default settings.

CTRL+N

0

Open.. Opens an existing DPS-view data structure.

Ctrl+0
=

Save Saves a changed data structure.

Ctrl+S

|

Save as... Saves the currently open data structure under a different name.
Close Ends DPS-view-Edit.

Alt+F4

Summary of the pull-down menu " Edit"

Undo Undoes the last administrative change.

Ctrl+Zz

Restore Restores and executes the last administrative change that was
Ctrl+y undone.

Submenu "Order"

Bring to top Use this menu item or shortcut to move an object to the fore-
Ctrl+Posl ground.

» see Section 4.6.6 "Change the order of objects (Z-Level)"
Move up Use this menu item or shortcut to change the position of an ob-
Ctrl+Page Up ject in the sequence, and move it to the next higher level on the

screen.

» see Section 4.6.6 "Change the order of objects (Z-Level)"
Move down Use this menu item or shortcut to change the position of an ob-
Ctrl+Page down ject in the sequence, and move it to the next lower level on the

screen.

» see Section 4.6.6 "Change the order of objects (Z-Level)"
Move to end Use this menu item or shortcut to move an object to the back-
Ctrl+End ground.

» see Section 4.6.6 "Change the order of objects (Z-Level)"
Table 4-1 Menu items, icons and buttons in DPS-view-Edit
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DPS-view-Edit - Main View

Menu item

Description

Summary of the pull-down menu "Tools"

Move image
Ctrl+B

=]

Use this menu item or shortcut to move an image on the map.

Submenu " Object"

Move
Ctrl+G

[=]

Use this menu item or shortcut to move an object on the map.

Ctrl+T

!

Undo assignment

Use this menu item or shortcut to disengage an object from its
assigned graphic image.

Delete
Delete

|

Use this menu item or shortcut to delete an object from the map.

Submenu "Polygon"

Create
Ctrl+L

4|

Use this menu item or shortcut to create a new polygon.

Edit
Ctrl+P

L]

Use this menu item or shortcut to move individual points of a
polygon.

Assign object
Ctrl+A

Use this menu item or shortcut to assign an object to a polygon.

Add point
Ctrl+d

Use this menu item or shortcut to add a point to a polygon.

Delete point
ALT+Delete

|

Use this menu item or shortcut to remove a point from a polygon.

Copy
Ctrl+C

A

Use this menu item or shortcut to copy a polygon.

Table 4-1

Menu items,
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Menu item Description

Paste Use this menu item or shortcut to paste a copied or cut polygon

Ctrl+v from the clipboard.

Cut Use this menu item or shortcut to cut a polygon and copy it to the

Ctrl+Xx) clipboard

Delete Use this menu item or shortcut to remove a polygon and copy it

Ctrl+Del to the clipboard.

A= |

Summary of the pull-down menu "Project"

Migrate... Use this menu item or shortcut to migrate already existing data

Ctrl+M structures from DPS-view V1.xx, and save them in the current
DPS-view Version.

Visualization templates Use this menu item or shortcut to edit the visualization templates

Ctrl+Alt+T of a project.

Submenu "Import object list"

To import an object list to DPS-view-Edit, you must start by cre-
ating and saving a DPS-view import file in the application OS-
cAR Positioning Services of the OScAR-TT Administrator-Tool
("Create DPS-view import files..."), i.e. a . txt text file (name

and storage place freely selectable).

» see OScAR-Pro User Manual

From file... Opens a window to import objects from a transfer file previously
Ctrl+1 created in OScAR Positioning Services in the OScAR-TT Ad-
ministrator-Tool in form of a . txt text file and saved.

From project... Opens a window to import objects of a project which already ex-
Ctrl+R ists in DPS-view-Edit, and that were previously and successfully
savedin form of a . dps file and saved (name and storage place

%l freely selectable).

Summary of the pull-down menu "Levels":

New Use this menu item or shortcut to add a new level.
Ctrl+Shift+N

Table 4-1 Menu items, icons and buttons in DPS-view-Edit
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DPS-view-Edit - Main View

Menu item Description
Edit Use this menu item or shortcut to edit the attributes of a level.
Ctrl+Shift+E
Copy Use this menu item or shortcut to copy a level with all its attri-
Ctrl+Shift+C butes and settings.
Paste Use this menu item or shortcut to paste a copied or cut level at
Ctrl+Shift+V the wanted position in the tree.
Cut Use this menu item or shortcut to copy a level to the clipboard.
Ctrl+Shift+X
Delete Use this menu item or shortcut to remove a level from the struc-
Ctrl+Shift+Delete ture tree.

bl

Pull-down menu " Object"

New Use this menu item or shortcut to add a new object to the object
Ctrl+F list manually.

|

Edit Use this menu item or shortcut to edit the attributes of an object.
Ctrl+D

Delete Use this menu item or shortcut to remove an object from the ob-
Ctrl+H ject list.

=

Submenu "Sort"

ID Use this menu item or shortcut to sort the object list by ID.

Ctrl+l

Type Use this menu item or shortcut to sort the object list by object

Ctrl+2 type.

Info Use this menu item or shortcut to sort the object list by object in-

Ctrl+3 fo.

Status Use this menu item or shortcut to sort the object list by object

Ctrl+4 status.

Table 4-1 Menu items, icons and buttons in DPS-view-Edit
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DPS-view-Edit - Main View

4-8

Menu item

Description

Summary of the pull-down m

enu " Options"

Parameters...

Use this menu item to edit the parameters and settings of DPS-
view.

Predefined visualization tem-
plates...

Edit predefined templates for the visualization.

Grid

Use this function to locks objects or polygons to the grid.

Submenu "Language'

German Switches the language of the DPS-view-Edit user interface to
German.
English Switches the language of the DPS-view-Edit user interface to

English.

Summary of the pull-down m

enu "View"

Status bar

Shows and hides the status bar.

Submenu " Symbol bar"

File

Click this item to activate the icons for the toolbar "File".

Objects Click this item to activate the icons for the toolbar "Objects".
Level Click this item to activate the icons for the toolbar "Level".
Tools Click this item to activate the icons for the toolbar "Tools".
Edit Click this item to activate the icons for the toolbar "Edit".
Arrange Click this item to activate the icons for the toolbar "Arrange".

Summary of the pull-down m

enu ur?u

About DPS-view-Edit ...

Opens the window with the version number and the copyright in-

F1l formation.
®?
Table 4-1 Menu items, icons and buttons in DPS-view-Edit
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DPS-view-Edit - Main View

41.2 The Object list

The Object list itemizes all Base Stations, WLAN Access Points and Areas of Interest:

4

1D [1p-.. [ Info | Status ~]
00:0F:BE:12:EE:69 AP AP-01: Loungs Current level
00;0F:BE: 12:EB: 64 AP AP-01; Lounge Currenk level
00:0F:EB: 12:EA LS ap AP-02: Production Area 1st Floor | Prallel level
O0:0F:EE: 12:EA:LD AP AP-02: Production Area 2nd Floor | Prallel level
00:0F:BE: 12:EA: 1A AP AP-02: Production Area 1st Floor | Prallel level
00:0F:BE:12:ED: 28 AP AP-03: Accounting Prallel level
00:0F:BE: 12:ED:29 AP AP-03: Accounting Prallel level
00;0F:BE: 12:ED: 24 AF AP-05: Accounting Prallel level
00:0F:BB:12:EC:DE ap AP-04: R0 15t Floor Prallel level
O0:0F:BE: 12:EC: DY AP AP-04: R&D 1st Floor Prallal level
00:0F:BE: 12:EC: DA ap AP-04: R&D 1st Floor Prallel level
00:0F:EB:11:C4:98 AP AP-10: Conf. Room 2nd Floor Current level
00:0F:BE:11:C4:99 AP AP-10: Conf, Room 2nd Floor Current lewvel
O0:0F:EB:11:C4:94 AP AP-10: Conf. Roorm 2nd Floor Current level
00:0F:BE:12:E7:08 AP AP-05: Assembly Prallel lewvel
00;0F;BE:12:E7:09 AP

AP-05; Assembly Prallel level | >
» I

Image 4-2  List of objects - ID-Types

Sort the List of objects

You can sort the List of objects in the following ways:

e  (Click the head of the column

e Inthe menu, click: Object—> Sort=> ID
Object—> Sort=> ID-Type
Object—> Sort=> Info
Object—> Sort=> Status
The entries in the List of objects have the following columns:
Entry Description
ID The identifier is the identification number of the object:
e for a DECT Base Station: DECT-ID + SLC no. + Port no.,
e for a WLAN Access Point: the MAC address
[max. 32 characters]
ID-Type The ID-Type specifies the object type:
e BS =Base Station
e AP =WLAN Access Point
e AOI =Area of Interest
e SITE =Site
[max. 4 characters]
Info The info text described the object, e.g. "2nd floor right".
[max. 64 characters]
Table 4-2 Columns of the Object list
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DPS-view-Edit - Main View

4-10

Entry

Description

Status

Can be placed

This object can be placed in the current level.

Parallel level

This indicates that the object has already been placed on a parallel level
and as a result, you cannot place it again. When you click an object of this
type, the link will take you directly to the first sublevel in the tree structure
where this object appears, i.e. you can reach the parallel level by making

a click on a unique object in the present level, or by making a click in the
navigation bar.

Can be placed

This indicates that the object cannot be placed in the current level because
it has not yet been placed in the next higher level.

Current level

This indicates that the object is already placed in the current level and can
therefore not be placed in this level a second time.

Table 4-2

Columns of the Object list

P31003-S1750-M103-01-76A9, 08/2021
OSCcAR Positioning System-view, Administrator Manual




The Administrator Tool DPS-view-Edit

Local parameters

4.2 Local parameters

With the exception of the predefined visualization templates, the local settings of DPS-view-Edit

are saved in the Registry.

In contrast, the predefined visualization templates are saved in a separate directory.

"<DPS-view path> + Editor + Templates"

The function Edit parameters is opened as follows:
Options=>

e  via the menu bar:

4.2.1 Edit local parameters

Parameters...

The local parameters of DPS-view-Edit are configured in the following window:

i Edit parameters

[=- General

L Wertical dista
[#- Draw palygon
[#- Color in object list

Walue:

Haorizantal distance

o Ok

End

e

yes

[ 2pply changes

Lizt of pozsible paramters. ..

Image 4-3 DPS-view-Edit - Local parameters

Description of the fields and parameters in the user window " Edit parameters”:

Entry | Description

General

Crosshairs Shows the crosshairs when you are drawing a polygon.
[yes], no

General - Grid

Show Shows the grid when editing a map.
[no], yes

Lines Shows the grid in form of lines.
[no], yes

Color Defines the color of the grid points or grid lines.

000000 .. FFFFFF, [909090]

Horizontal dis-
tance

1 .. 100 Pixel, [10 Pixel]

Defines the horizontal space between grid points, in pixels.

Vertical distance

Defines the vertical space between grid points, in pixels.
1.. 100 Pixel, [10 Pixel]

Table 4-3
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Local parameters

4-12

Entry

Description

Draw polygons

Color

Defines the color that the polygon has during the drawing process.
000000 .. FFFFFF, [0000FF]

Transparency Defines the transparency that the polygon has during the drawing process.
0% .. 100%, [0%]

Frame width Defines the width that the polygon's frame has during the drawing process,
in pixels.
1.. 5 Pixel, [1 Pixel]

Frame color Defines the color that the polygon's frame has during the drawing process.

000000 .. FFFFFF, [000000]

Sensitivity to new
points

Defines the sensitivity of the cursor when you add new points to a polygon,
in pixels.
1.. 5 Pixel, [2 Pixel]

Draw polygons - Points

Size

Defines the size that the points of a polygon have during the drawing pro-
cess, in pixels.
1.. 20 Pixel, [5 Pixel]

Color

Defines the color that the points of a polygon have during the drawing pro-
cess, in pixels.
000000 .. FFFFFF, [900000]

Frame width

Defines the frame width that the points of a polygon have during the drawing
process, in pixels.

1 .. 5 Pixel, [1 Pixel]

Frame color

Defines the frame color that the points of a polygon have during the drawing
process.

000000 .. FFFFFF, [000000]

Draw polygons - Selected points

Size

Defines the size that the selected points of a polygon have during the draw-
ing process, in pixels.

1.. 20 Pixel, [6 Pixel]

Color

Defines the color that the selected points of a polygon have during the draw-
ing process, in pixels.
000000 .. FFFFFF, [900000]

Frame width

Defines the frame width that the selected points of a polygon have during the
drawing process, in pixels.

1..5Pixel, [1 Pixel]

Frame color

Defines the frame color that the selected points of a polygon have during the
drawing process.

000000 .. FFFFFF, [00FF00]

Color in object list

Object can be
placed

Defines the color of the text of an object that can be placed.
000000 .. FFFFFF, [000000]

Object in current
level

Defines the color of the text of an object that is placed in the current level.
000000 .. FFFFFF, [0000FF]

Object in parallel
level

Defines the color of the text of an object that is placed on the parallel level.
000000 .. FFFFFF, [FFO000]

Table 4-3

DPS-view-Edit - Edit local parameters
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422

4.2.3

Entry Description
Object under the | Defines the color of the text of an object above which you are currently mov-
mouse pointer ing your mouse Ccursor.

000000 .. FFFFFF, [00FF00]

Object cannot be | Defines the color of the text of an object that CANNOT be placed in the cur-

placed rent level.
000000 .. FFFFFF, [505050]
Table 4-3 DPS-view-Edit - Edit local parameters

Predefined visualization templates

The function Predefined visualization templates is opened in the following way:
e via the menu bar: Options=> Predefined visualization templates...

More information on the predefined visualization templates can be found here:

» see Section 4.3 "DPS-view-Edit visualization templates"

Select alanguage
You can change the language of the user interface in the following ways:

e viathe menu bar: Options=> Language—> German
e viathe menu bar: Options=> Language=> English
Caution!

Changes of the language setting only take effect after the next start of the program.

424

4.2.5

P31003-S1750-M103-01-76A9, 08/2021

Grid
The function Grid is opened as follows:
e via the menu bar: Options=> Grid

e  Orviathe toolbar:

Use this function to activate the grid and have the cursor locked to the grid points when you are
placing objects or drawing polygons.
You can change the width of the grid as follows:

. Options% Parameters
» see Section 4.2 "Local parameters"

Zoom
The function Zoom is opened as follows:

e  orvia the toolbar: Zc--:vmzllnn% vI

This function enables you to scale up the map you are currently editing between 50% and 500%.

4-13
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4.2.6

4-14

Simulation of the visualization

For the output of Access Points, Base Stations and Areas of Interest, the intensity of the received
field strength or the positioning quality is simulated in a value ranging between 0% and 100% (con-
figurable).

During this process, all objects that share the same level are output with the selected simulation
size.

The function Simulation is opened as follows:

*  orvia the toolbar: Saleiee 90

The below image shows several DECT Base Stations and one Area of Interest (is the most
probable location)in the way they are output by the system with different simulation values
(100% to 0%):

Image 4-4  Simulation of intensity and object quality DECT BS and AQI
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4.3 DPS-view-Edit visualization templates

Visualization templates are masks that are used to visualize objects. Their describe how the form
in which the objects that are received by DPS-view shall be shown. Depending on the type of vi-
sualization template that is used, the visual output can vary in terms of the object type, the simu-
lation size and the quality or intensity of the positioning.

The following visualization templates are available:

¢  Predefined visualization templates
e  Project-specific visualization templates

Note:

In the administration of visualization templates, the list of predefined visualization templates al-
ways appears first.

Predefined visualization templates

The administration of predefined visualization templates is made in the local work environment of
the Administrator Tool DPS-view-Edit.

» see Section 4.2 "Local parameters"

DPS-view-Edit saves these settings on the local hard disc in the directory "templates™". Itisin
this directory that all attributes of the predefined visualization templates are stored.

The name of the subdirectory of a "Predefined visualization template" underthe "tem-
plate™ directory reads:
DEF<x> <Name of the "Predefined visualization template">
For the name of these subdirectories the system uses the following place holders:
i <xX>
- This is the serial number that is automatically inserted by DPS-view-Edit
<Name of the "Predefined wvisualization template">

- This is the name of the predefined visualization template, with all special characters re-
moved.

Note:

Predefined visualization templates can also be exchanged among the administrators of DPS-
view. To exchange templates, all you need to do is copy the subdirectory of the pertinent pre-

defined visualization template to the wanted "template" directory. At the next program start,
DPS-view will find and apply the newly added predefined visualization template.

Project-specific visualization templates

The project-specific visualization templates are stored together with its respective project. You can
either create a project-specific visualization template freely or upload an already available pre-
defined visualization template and then edit it further if needed.

» see Section 4.3.1 "Predefined visualization templates - Lists"

» see Section 4.3.2 "Create and edit a visualization template"

Note:

However, you can also save a project-specific visualization templates as a predefined template,
and subsequently make it available for other projects as well.

P31003-S1750-M103-01-76A9, 08/2021
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4.3.1

4-16

Predefined visualization templates - Lists

List of the Predefined visualization templates
The list of Predefined visualization templates is opened as follows:

e via the menu bar: Options=>

Predefined visualization templates...

@ Predefined visualization templates x|
—Wizualization templates
Mame | Type | Gradu... | | o Dk |
Fire detectar Image -
DECT baze station Image list 12 | End |
WLAN access point Image list 12
Area of interest Palpgon -
| 2] New.. | | = Edi.. | | i Delete...

List of predefined visualization templates...

Image 4-5

List of Project-specific visualization templates

Options - Predefined visualization templates

The list of Project-specific visualization templates is opened as follows:
Project—> Visualization templates...

e  via the menu bar:

‘m Project-specific visualization templates |
—Wisualization template:
Mame | Tupe | Gradu... | | s |
Area of interest Paolygon -
DECT base station Image list 12 | End |
Fire detectar Image -
WLAN access paint Image list 12
B ase station with beam antenna Color level polygon with list of... 12
| B Mew... | | = Edt.. | | il Delete...

List of all vizualization templates uzed in this project..

Image 4-6

Window Project-specific visualization templates
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4.3.1.1

®

Predefined visualization templates: Fire detector

Note:

4.3.1.2

» see Section 4.4.1 "Default settings for "Image

The predefined visualization template that is automatically included in the delivery for the graphic
output "Fire detector" uses the default settings of the visualization type "Image".

Scaling

Image

100 %

Table 4-4

Ex-works visualization templates - Fire detector

Predefined visualization templates: Area of Interest (AOI)

®

Note:

The predefined visualization template that is automatically included in the delivery for the graphic
output of an "Area of interest", i.e. of the most probable location, uses the default settings of the
visualization type "Polygon".
» see Section 4.4.3 "Default settings for a 'Polygon"

Filling color Frame color Transparency Frame width View
FF0O000 000000 60% 1 pixel |:|
Table 4-5 Ex-works predefined visualization templates - Area of Interest (AOI)
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4.3.1.3

Predefined visualization template: DECT Base Station

®

Note:

4-18

The predefined visualization template included in the delivery for the graphic output of a 'DECT
base station' uses the default settings of the visualization type 'Image list'.

» see Section 4.4.2 "Default settings for "Image list

Graduation from to Scaling Image
Visited - - 100% -
o
Not received - - 44% ()
1. Graduation 95% 100% 100% =
2. Graduation 90% 95% 95% r__
3. Graduation 85% 95% 85% r__
4. Graduation 80% 85% 80% —
5. Graduation 75% 80% 75% r‘
6. Graduation 70% 75% 70% e
7. Graduation 65% 70% 65% [~
8. Graduation 60% 65% 60% [
9. Graduation 50% 60% 50% M
10. Graduation 35% 50% 48% (i

Table 4-6

Ex-works predefined visualization templates - DECT Base Station
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4.3.1.4

Graduation from to Scaling Image
11. Graduation 20% 35% 46% =
12. Graduation 0% 20% 44% ~

Table 4-6

Ex-works predefined visualization templates - DECT Base Station

Predefined visualization template: WLAN Access Points.

®

Note:

The predefined visualization template included in the delivery for the graphic output of a "WLAN
Access Point' uses the default settings of the visualization type 'Image list', with the images for
Base Stations replaced by those for Access Points

» see Section 4.4.2 "Default settings for "Image list

Graduation from to Scaling Image
Visited - - 100%
Not received - - 44% {@]
1. Graduation 95% 100% 100% l@_’
2. Graduation 90% 95% 95% H
3. Graduation 85% 95% 85% l I'
4. Graduation 80% 85% 80% ‘ "
5. Graduation 75% 80% 75% l '
6. Graduation 70% 75% 70% |E j'

Table 4-7

Ex-works predefined visualization templates - WLAN Access Points
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Graduation from to Scaling Image

7. Graduation 65% 70% 65% =

8. Graduation 60% 65% 60% =

9. Graduation 50% 60% 50% =
10. Graduation 35% 50% 48% &
11. Graduation 20% 35% 46% =
12. Graduation 0% 20% 44% &

Table 4-7 Ex-works predefined visualization templates - WLAN Access Points
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Summary of the fields in the user windows " Predefined visualization templates" and " Proj-
ect-specific visualization templates”

—Wizualization template:

Mame | Type | Gradu... |
Area of Interest Palygon -
DECT-B asisstation Image list 12
Feuermelder Image -
AN -Aocesspoint Image list 12
Gerichtete Bagizstation Color gpectum polygon with i... 12
Area of Interest HPS Palygon

| "i%ﬂew... | |

E dit selected vizualization template...

Image 4-7  Window Project-specific visualization templates

—Wizualization templates
Mame Type Gradu... I ¢ Ok I
Feuemelder lmage [ |
DELCT-B azizstation Image list 12
wLAMN-Accesspoint Image list 12
Area of [nterest Polygon -
I
Bl New... | | = Edt.. | | 1iJ Delste... |
List of predefined visualization templates...

— — =

Image 4-8  Window Predefined visualization templates
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4-22

Menu bar/ button

List "Visualization templates"

Description
Columns:
e Name
e Type

e  Graduation

New Use this button to create a new and empty predefined
visualization template.

Edit Use this button to edit an already existing predefined vi-
sualization template.

Delete Use this button to delete an existing predefined visual-
ization template.
When you click this button, the system will ask you to
confirm the following security prompt:
=

\-?/ Do vou really want to delete the visualization template 'DECT base station'?
Ja I Mein |
Table 4-8 Window: Predefined visualization templates/Project-specific visualization tem-

plates
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4.3.2 Create and edit a visualization template

Visualization template - Properties and attributes

The general attributes are the properties that are shared by all visualization template types. All
other attributes and properties depend on the visualization type you select. Here, new or edited
visualization templates can be saved locally in form of a new predefined visualization templates.

- General attributes
M are:

IFire detectol

Type:

IImage ..d

E} Load non-editable facton settings

Image 4-9  Create/edit visualization template - General attributes

- General attbutes — Predefined wizualization termplates
M arme: M arne:
I.ﬁ.rea of interest I.-’-'-.rea of interest ;I
Type:
IF'DI_I,Ign:ln j = Load predifiend visualization template
% Load non-editable factons zettings E Save az predefiend visualization template

Image 4-10 Create/edit a visualization template - Purs. to visualization type

Summary of the fields in the user windows "Edit predefined visualization template" and
"Add new predefined visualization template"

Menu bar/ button Description

General attributes (same for predefined visualization templates and project-specific visu-
alization templates)

Name The name of the predefined visualization template.
[0 .. 32 characters; "]
Type Use this drop-down combo to select the type of the vi-

sualization template. The following templates are avail-
able:

e Image

e Image list

e Color spectrum polygon

e Color spectrum polygon with image

e Color spectrum polygon with list of images
e Polygon

e  Polygon with image

e Polygon with list of images

For further details on the different settings and options
available, please see below.

Table 4-9 Window visualization template - Create/edit
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4-24

Menu bar/ button

Description

Load default settings

Click here to upload the default settings for the selected
visualization type.

When you click this button, the system will ask you to
confirm the following security prompt:

DPS-view-Edit ) Xl
‘_?r) Do you really want to load the Factory settings for the selected type?
Ja I Mein |

Further details on the default settings for the individual
visualization types can be found here:

» see Section 4.4 "Default settings"

Predefined visualization templates (only under Project-specific visualization templates)

Visualization templates

Drop-down combo with all predefined visualization tem-
plates available

Load predefined visualization template

Use this button to upload the predefined visualization
template you selected in the combo-box, and copy it to
the project as a project-specific visualization template.

Save as predefined visualization tem-
plate

Use this button to save locally the current project-spe-
cific visualization template as a predefined one.

Type

Use this drop-down combo to select the type of the vi-
sualization template. The following templates are avail-
able:

e Image

e Image list

e Color spectrum polygon

e Color spectrum polygon with image

e Color spectrum polygon with list of images

e Polygon

e  Polygon with image

e Polygon with list of images

For further details on the individual attributes and set-

tings, including the options they offer, please see below.

Table 4-9 Window visualization template - Create/edit

P31003-S1750-M103-01-76A9, 08/2021
OSCcAR Positioning System-view, Administrator Manual




The Administrator Tool DPS-view-Edit
DPS-view-Edit visualization templates

4.3.21 Visualization type "Image"

The Image attributes listed here refer to the visualization type "Image" . A typical example for a
visualization templates of the type "Image" is the fire detector that is output by DPS-view-Edit at
a predefined location when a fire breaks out. Here, the only attribute that can be edited is the im-
age's scaling factor.

Image attnbutes |

— Attributez — Preview

Scaling I 100 ZE:

[ Select image...

Image 4-11 Edit visualization template - Visualization type "Image’

Summary of the fields in the user window area " Image attributes" for the visualization type
nwu |magell :

Menu bar/ button Description
Scaling Use this field to select the scaling factor for the image
based on its real size, in per cent.
0 .. 1000%, [100%]
Select Image... Click this button to open the following dialog and select

the Image you want to use. Bear in mind that only imag-
es of the type .gif are accepted here.

No other formats can be output by the system.

open 2|

Loak in: I_} DEY4_WLAN access points .:J L] |‘=_“'F Ef-

=Jaren:

File narme: ]STGD Open I
Files of type: [ GIF files [* gif =] Cancel I

[~ Open a3 read-only

Z

Preview The window area Preview shows you how the image
will appear in DPS-view, in keeping with the configured
Scaling factor.

Table 4-10 Description of menus in window: Image attributes for an image
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4322

4-26

Visualization type "Image list".

The Image attributes listed here refer to the visualization type "Image list". A typical example for
the visualization templates of the type "Image list" is the DECT Base Station or a WLAN Access
Point, the color and size of which appear in keeping with their received field strength graduation
for positioning processes with no interpretation of the obtained results.

The list of field strength graduations contains the following entries:

Visited

Every object that the system classifies as " Visited" is shown with a specific icon and its de-
fined graduation parameters. For example, a mobile handset in a cellular network (DECT/
WLAN) may be communicating via several Base Stations but its actual datasets are only
transmitted via one specific Base Station, the so-called "Visited Base Station" or "Visited
station".

For the field strength graduation "Visited", the only attribute that can be edited is image's the
scaling factor.

Not received

All objects that are characterized as "Not received" are represented with a specific icon and
that icon's graduation parameters. This may prove helpful when you need to analyze ob-
tained positioning results as it shows you where all objects that the system could not receive
are physically located.

1.1to 12. Graduation

In the graphic output of an object that is received with a specific field strength, the system
will select the corresponding symbol from the field strength graduation list, with set margins
of values between 0% and 100%.

Irmage attributes |
— Field strength graduations — Graduation parameters
[Fraduatian | fru:uml t|:|| Sca.. | File ni A! Fram:
2. Giraduation 90%  95%  95% STG1 | g5 %=
3. Graduation ahk | 90%  BARx STGE
4. Graduation a0k | 8% BOx STG3 T
5. Graduation 7Rk B0%  YRx STG4 :
E. Graduation Tk 7Rx: YO STGH I 100 “/__I:
7. Graduation BRE  70%  BBX STGE
8. Graduation BO0% | EBB%  BO% STGY
9. Graduation 0% BO® 50X STGS Scaling:
10, Graduation 5% BOx 48% STGS I 100 % E]
11. Graduation 20%  3R%x 4B% STG1 -
12, Graduation 0% 20% 44% STG1
- = Select Image...
| | on
=l Mew [ Delete [ tpply changes

Image 4-12 Edit visualization templates - Visualization type "Image list"
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Summary of the fields in the user window area " Image attributes" for the visualization type

"Image list":
Menu bar/ button Description

Field strength graduations

New Use this button to add a new graduation to the list. The
list can hold a maximum of 12 different graduations.

Delete Use this button to delete a field strength graduation
from the list.

Graduation Columns:

e  Graduation

e from

e o

e Scaling

e File name: This is the name of the file from which
the image was imported

Graduation parameters

From Shows the the margin of values in percent for the

To marked graduation interval ['"From:", "To:"].

0..100% , [100%]

Scaling Use this field to select the scaling factor for the image
based on its real size, in per cent.
0 .. 1000%, [100%]

Select Image... Click this button to open the following dialog and select
the Image you want to use. Bear in mind that only imag-
es of the type .gif are accepted here.

No other formats can be output by the system.
open 21|
L ook i I_? DEV4_"wWLAN access points _‘J (=] |‘=_“F Ex-
[mfsTao:
File namme; ISTGD Open I
Filez of type: |GIFfiIes [*.qifl j Cancel |
[ Dpen as read-only v

Preview The window area Preview shows you how the image
will appear in DPS-view, in keeping with the configured
Scaling factor.

Apply changes Use this button to save your changes of the graduation
parameters in the list "Field strength graduations" on
the left.

Table 4-11 Description of menus in window: Image attributes for Image list
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4.3.2.3

4-28

Visualization type "Polygon"

The polygon attributes listed here refer to the visualization type "Polygon". A typical example of
a visualization template of the type "Polygon" is an "Area of Interest", i.e. the area in which the
device is most likely located.

Palygor attributes |

—attributes — Preview
Filing calor: Frame colar:
[ Froooo [ ] [ oooo00 [ |
Tranzparency: Frame width:

| B0 ?Q_E | I]F'iwel__l;

Image 4-13 Edit visualization template - Visualization type "Polygon"

Summary of the fields in the user window area "Polygon attributes" for the visualization
type "Polygon":

Menu bar/ button Description
Filling color Use this button to open the user window to select the
color with which you want the polygon to be filled.
000000 .. FFFFFF, [FFO000]
Frame color Use this button to open the user window to select a col-
or for the polygon frame.
000000 .. FFFFFF, [000000]
Transparency Use this button to open the user window to select the
transparency with which the polygon is output.
0 .. 100%, [60%]
Frame width Use this button to open the user window to select the
width of the polygon frame.
0 .. 100 Pixel, [1 Pixel]
Preview Preview of the graphic output of the polygon with the
entered values.

Table 4-12 Description of menus in window: Image attributes for Polygon
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4324 Visualization type " Color spectrum polygon"
The polygon attributes listed here refer to the visualization type " Color spectrum polygon". A
typical example of a " Color spectrum polygon" is the graphic output of an " Area of Interest"
(most probably location) with a computed positioning result whose quality matches a set value
range which lies within the overall margin of values between 0% and 100%.
Here, the color of the polygon mirrors the quality of the positioning results.
Just like the "Image list" (» see Section 4.3.2.2 "Visualization type "Image list"."), the "Color
spectrum polygon" also spans the following field strength graduations:
o Visited
Objects that the system classifies as " Visited" are shown with their specific graduation pa-
rameters. The system applies the visualization option " Visited" if it finds itself unable to ob-
tain specific information on the field strength quality during the map query.
e Not received
An"Areaof Interest" (most probable location) that the system characterizes as not received,
is shown with the specific graduation parameters. This may prove helpful when you need to
analyze obtained positioning results as it shows you where all objects that the system could
not receive are physically located.
e 1.to 12. Graduation
In the visual output of an object that is received with a specific field strength, the system will
select the corresponding icon from the list of field strength graduations, with set margins of
values between 0% and 100%.
Palygon attributes |
— Field strenath graduationz — Graduation parameters
Graduation | from | to|  Color] | Frar:
Visted : - 000000 | | Dz
Mot received : - oooooo
1. Graduation 95%  100%  FFOO00 . To
2. Graduation 0z 95%  FFa040 =@ Iﬁa -
3. Graduation 5% 0%  FFa000 B i <2
4. Graduation 80%  85% FFFFOO Fill i
5. Graduation 75%  80% OOFFOO 00 SRR O
B. Graduation FLIES A% O0FFFF | Q020FF
7. Graduation [Flak F0%  BOFFBD
8. Graduatil:un B0 B5% | BOFFFF Frame calor: Tranzparency:  Frame width:
9, Graduation Bh% E0%  00FFO0 B o -
10, Graduation | 0% | O0E0FF | | | 000000 III | 0% 1 Pisel =
2] New Il Delete = &pply changes
Image 4-14 Visualization templates - Visualization type "Color spectrum polygon"
Summary of the fields in the window area "Polygon attributes" for the visualization type
"Color spectrum polygon":
Menu bar/ button Description
Graduation parameters
From Shows the margin of values in percent for the marked
To graduation interval ['"From", "To"].
0..100%
Filling color Use this button to open the user window to select the
color with which you want the polygon to be filled.
000000 .. FFFFFF
Table 4-13 Description of menus in window: Image attributes for Color spectrum polygon
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Menu bar/ button Description
Frame color Use this button to open the user window to select a col-
or for the polygon frame.
000000 .. FFFFFF [000000]
Transparency Use this button to open the user window to select the
transparency with which the polygon is output.
0 .. 100%; [60%]
Frame width Use this button to open the user window to select the
width of the polygon frame.
0 .. 100 Pixel, [1 Pixel]

Preview Preview of the graphic output of the polygon, with the
configured values.

Apply changes Use this button to save your changes of the graduation
parameters in the list "Field strength graduations" on
the left.

Field strength graduations

New Use this button to add a new graduation to the list. The
list can hold a maximum of 12 different graduations.

Delete Use this button to delete a field strength graduation
from the list.

Graduation Columns:

e  Graduation
e from
e to
e Color
Table 4-13 Description of menus in window: Image attributes for Color spectrum polygon
4325 Edit visualization template "Polygon with image"

The visualization template of this type consists of the following components:

e Image
» see Section 4.3.2.1 "Visualization type "Image""
e Polygon

» see Section 4.3.2.3 "Visualization type "Polygon""

A typical example of a visualization template of the type "Polygon with image" is fire detector

that stretches a specific area, i.e. an Area of Interest (i.e. the area in which the device is most likely
located).

Note:

When a fire alarm is raised, the system will here show both the image for the fire detector image
plus the polygon itself.
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4.3.2.6 Visualization template "Polygon with list of images"
The visualization template of this type consists of the following components:

e Image list

» see Section 4.3.2.2 "Visualization type "Image list"."
e Polygon

» see Section 4.3.2.3 "Visualization type "Polygon

A typical example for a visualization template of the type "Polygon with a image list" is a Base
Station, the coverage area of which shall be shown as an Area of Interest (i.e. as the most prob-
able location.

Note:

The color with which this Base Station is rendered on the map changes depending on the inten-
sity of the field strength with which the Base Station is received, whereas the Area of Interest (i.e.
the most probable location) is always shown with the same color.

4.3.2.7 Visualization template " Color spectrum polygon with image"
The visualization template of this type consists of the following components:
e Image
» see Section 4.3.2.1 "Visualization type "Image

e (Color spectrum polygon
» see Section 4.3.2.4 "Visualization type "Color spectrum polygon

A typical example of a visualization template of the type "Color spectrum polygon with image"
is an Area of Interest (i.e. the most probably location), the quality of which shall be output by the
system in form of a positioning result. Here, to heighten the visibility, the graphic output shall be
supported by an additional icon, e.g. a Base Station.

4.3.2.8 Visualization template " Color spectrum polygon with list of images"
The visualization template of this type consists of the following components:

e Image list

» see Section 4.3.2.2 "Visualization type "Image list"."
e Color spectrum polygon

» see Section 4.3.2.4 "Visualization type "Color spectrum polygon

A typical example of a visualization template of the type "Color spectrum polygon with list of
images" is is a Base Station or a WLAN Access Point (i.e. the most probably location) whose cov-
erage area shall be shown in form of an Area of Interest (AOI), with the color of the AOI varying
in keeping with the intensity of the received field strength.

Note:
The color with which a DECT Base Station or WLAN Access Point is shown on the map changes
analogous to the intensity of the field strength with which that DECT Base Station or WLAN Ac-
cess Point is received.

In addition, the color of the polygon with which the Area of Interest (i.e. the most probable loca-
tion) is shown also changes depending on the field strength.
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4.4 Default settings
4.4.1 Default settings for "Image"
Scaling Image
100 % I
Table 4-14 Default settings "Image"
442 Default settings for "Image list"
Graduation From to Scaling Image
Visited - - 100%
Not received - - 100%
=
1. Graduation 95% 100% 100%
2. Graduation 90% 95% 95% r__
3. Graduation 85% 95% 85%
4. Graduation 80% 85% 80%
5. Graduation 75% 80% 75%
6. Graduation 70% 75% 70%
7. Graduation 65% 70% 65%
Table 4-15 Default settings "Image list"
4-32 P31003-S1750-M103-01-76A9, 08/2021

OSCcAR Positioning System-view, Administrator Manual




The Administrator Tool DPS-view-Edit

Default settings

4.4.3

4.4.4

Graduation From to Scaling Image
8. Graduation 60% 65% 60%
9. Graduation 50% 60% 50% F_
10. Graduation 35% 50% 48% )
11. Graduation 20% 35% 46% -
12. Graduation 0% 20% 44% —
Table 4-15 Default settings "Image list"
Default settings for a 'Polygon’
Filling color Frame color Transparency Frame width View
FFO000 000000 60% 1 pixel [ ]
Table 4-16 Default settings "Polygon’
Default settings for "Color spectrum polygon"
Graduation | From to Filling Frame | Transpar-| Frame View
color color ency width
Visited - - FFOO00 | 000000 | 60% 1pixel | N
Not re- ; - 000000 | 000000 | 60% 1oxel (L ]
ceived
1 thr (fr‘fua' 95% | 100% | FFOOOO | 000000 | 60% 1oixel | R
2 thr sr‘fua' 90% | 95% | FF643C | 000000 | 60% 1oixel | ]
3. thr sr?“a' 85% | 95% | FFAF46 | 000000 | 60% 1oixel | ]
4. ﬁirs:“a' 80% | 85% | FFFFOO | 000000 | 60% 1oxel [ ]
S thr sr?“a' 75% | 80% | BEFA3C | 000000 | 60% 1pixel ||
6. ﬁirs:“a' 70% | 75% | 78FF0O0 | 000000 | 60% 1pixel | NN
Table 4-17 Default settings "Color spectrum polygon"
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Graduation | From to Filling Frame | Transpar- | Frame View
color color ency width
[ thr g‘:“a' 65% | 70% | 1EBEOO | 000000 | 60% 1pixel L ]
8. Gﬂr;?ua' 60% | 65% | OOFFAA | 000000 | 60% 1pixel | G-
S thr ;f'ua' 50% | 60% | 3CFAFA | 000000 | 60% 1pixel L ]
10. ?i;id“a' 35% | 50% | OOFO17 | 000000 | 60% 1pixel | ]
. ?i;id“a' 20% | 35% | OAG4FA | 000000 | 60% 1pixel | ]
12 ?i;id“a' 0% | 20% | 1414FA | 000000 | 60% 1pixel | G
Table 4-17 Default settings "Color spectrum polygon"

4.5 Levels

The DPS-view maps are stored in form of a hierarchically structured tree. The top level of this tree
is the so-called root level. You can nest the subordinate levels of the tree in any order you like.

Note:
@ Usually, a tree structure with maximally four sublevels is sufficient.

The below image describes a typical data structure in DPS-view-Edit:

B-Overvisw

- Taunusstein

é--SiIberbachstraﬁe

- 1sk Floor
underground parking
- 2nd Floor
-3rd Floor

- Top Floor

L Waldstrafie

Harmburg

~ Minchen

Image 4-15 DPS-view data structure - Example

The hierarchical tree structure corresponds to a tree on the hard disc and contains all the informa-
tion that is needed for the successful operation of DPS-view.

4.5.1 Edit the attributes of a level
The window to edit the "Attributes of the level xxx" is opened in these ways:
e via the menu bar: Levelt>Edit...
e or via the toolbar: fed
e viathe keyboard shortcut: Ctrl+Shift+E
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This will open the below dialog to edit the level attributes:

i Attributes of the level *1st Floor' x|
M ame; o [k
|1 st Floar
End
Object scaling in the curent level: I o0 333:

[~ Show not received objects on cunent level

(= Select image...

Level name(max. 32 char.]...

Image 4-16 Edit attributes of the level xxx

Summary of the fields in the user window " Attributes of the level xxx..."

Menu bar/ button

Description

Name

This is the name of the level that appears in the OScAR-
TT Operator-Tool as the map name and serves as the
caption on the corresponding navigation button.

» see Section 2.1 "Introduction and functionality"

Object scaling in the current level

This scaling factor is applied to all objects of the type "Im-
age" (not Polygons) that are placed on this level.

1..1000%, [100%]

Also show all not received objects of
this level

This level not only shows the objects that are received

but also the objects that are not received, in the selected

visualization.

» see Section 4.3 "DPS-view-Edit visualization tem-
plates"

Select Image...

Click this button to open the following dialog and select
the Image you want to use. Bear in mind that only images
of the type .9pg are accepted here.

No other formats can be output by the system.

open
x| e ® ek E

2]

Loak, ir; |\_'.' Mews Maps

,ij 1st Floor
%3] 2rd Floor

File narne: IDvewiew

Open I
j Cancel |

4

Files of type: [P files [*jpg)

[ Open az read-only

Table 4-18
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45.2

4.5.3

454

4.5.5

4.5.6

Add a new level

The function "Add new level in xxx" is opened as follows:

e viathe menu bar: Level”>  New...
e  orvia the toolbar: bﬁ
* viathe keyboard shortcut: Ctrl+Shift+N

Either of these commands will open the user window "Add new level in ...." to add a sublevel to
the level is currently marked in the tree view.

» see Section 4.5.1 "Edit the attributes of a level"

Delete a level

The function to delete an existing level is opened as follows:

e via the menu bar: Level=> Delete...
e  orvia the toolbar: Eg
e via the keyboard shortcut: Ctrl+Shift+Delete

Before this command is executed, the system will ask you to confirm if you really want to delete
the selected level. If you confirm with "Yes", the system will irrevocably delete the selected level
and all its sublevels. If you answer with "No", the system will immediately cancel the delete pro-
cess.

Copy a level

The function to copy an existing level is opened as follows:
e viathe menu bar: Level=> Copy

* viathe keyboard shortcut: Ctrl+shift+C

Use this function to cut a level and copy it to the clipboard. The level can then be pasted from the
clipboard and inserted at the wanted position in the tree.

Cut a level

The function to cut an existing level is opened as follows:
e viathe menu bar: Level=> Cut

e viathe keyboard shortcut: Ctrl+Shift+Xx

Use this function to cut a level and copy it to the clipboard. The level can then be pasted from the
clipboard and inserted at the wanted position in the tree.

Paste and insert a level
The function to insert a previously cut or copied level is opened as follows:

e via the menu bar: Level=> Paste
e viathe keyboard shortcut: Ctrl+Shift+V
Note:

You can only paste andinsert a level when all objects that are placed on this level are also placed
on the next higher level in the tree. If not, there would be inconsistency in the tree itself.

Consequently, the menu item "Paste" only becomes active when this condition is met.
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4.6 Objects
4.6.1 Import objects

To import objects into DPS-view-Edit, they must first be exported by OScAR Positioning Services
(DPS) as a text file (. txt).

» see OScAR-Pro User Manual
The objects consist of the following elements, with the "ID" together with "ID type" forming the ob-
ject's unique identifier.

e [Dtype: The ID type corresponds to the object type and can as-
sumes the following attributes:
- BS: a DECT Base Station
- AP a WLAN Access Point
- AOL Area of Interest (most probable location)
e |D: Depending on the object type, the ID of an object reads:

—  for a DECT Base Station: DECT-ID + SLC no. + Port no.
—  for a WLAN Access Point:  the MAC address
—  for an Area of Interest: the alphanumeric text
e Info text: The alphanumeric description of the object

4.6.2 Update object lists of existing projects

You can always add to or bring up to date a project's object list. If objects have already been cre-
ated in the project or imported into it, DPS-view-Edit will automatically ask if you really want to add
the data.

DPS-view-Edit x|

b ] The project already has objects,

"
If wou want to add the imported objects to the already existing ones, click "es' {objects will be aligned).

IF wou want ko replace the current lisk, click ‘Mo’ (current list will be deleted).

Ja I Mein | abbrechen

Image 4-17 Security query when importing objects

This security query can be answered as follows:

e No
DPS-view-Edit deletes the existing object list in the database and import the new list.
e Yes

During the import process, DPS-view-Edit verifies the unique object identifier consisting of
the ID and the ID type.
During this process the system can detect that:
—  The object already exists and the object data is identical:
In this case, DPS-view-Edit ignores the object as it is already included in the project.
—  The object already exists in the project but its object data is different:
In this case, DPS-view-Edit asks the user to confirm if he/she really wants to save the
new object data.

—  The object is not yet included in the project:
In this case, DPS-view-Edit adds the object to the object list with no further queries.
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4.6.2.1 Import object list from a text file

This function makes it possible to import objects from an object list (.txt) into DPS-view-Edit.

Note:

To import an object list from of a text file to DPS-view-Edit, that list must first be created and
saved in the application OScAR Positioning Services of the OScAR-TT Administrator-Tool
("Create DPS-view import files...") as a . txt text file. The name and storage place are freely
selectable.

To import objects of an object list from a file (. txt file), open the function "Import object list" as

follows:
e viathe menu bar: Project=> Import object list=> From file...
e viathe keyboard shortcut: Ctrl+I

Laok i |j DPS-view j = |‘=:F Ef-

Ei'lEditor

|_Server

File riame: IDbiectIisl Open I
File:s of type: |T><T files [* THT] j Cancel |/
%

Image 4-18 Project - Import object list - From file (.txt file)

In the window "Open", select the object list (.txt file) that contains the objects you want to import,
and click "Open".

After the import the system will output the new objects in the object list.
» see Section 4.1.2 "The Object list"

4-38 P31003-S1750-M103-01-76A9, 08/2021
OSCcAR Positioning System-view, Administrator Manual



The Administrator Tool DPS-view-Edit

Objects

46.2.2

®

Import an object list from a project

It may prove helpful to utilize the object of a project that already exists in DPS-view-Edit also in
other projects. This function enables you to import objects of an existing project into a different
DPS-view-Edit project..

Note:

To import objects of an existing DPS-view project to another project in form of an object list, you
need to save the original project as . dps file in DPS-view-Edit. The name and storage place are
freely selectable.

To do so, use the menu bar item: File = Save as..

®

Note:
In order to be able to save the objects of a project in DPS-view-Edit as a . dps file, the pertinent
project must be currently open.

Bear in mind that only one project can be open at a time.

To import objects of another project into your current project in form of an object list (. dps file),
apply the function "Import object list" as follows:

e via the menu bar: Project=> Import object list=> From project...
* viathe keyboard shortcut: Ctrl+R

(s | » DAKS-ProVE12 » - [ 4 [ paxs-
Organisieren ~ Neuer Ordner =~ [l ﬁ-
>
h Name Anderungsdatum Typ Grofe
) 2004, DPS-view-Edit Projekt_root 20.04 2017 14:05 Dateiordner
20,04, DPS-view-Edit Projekt_templates 20.04.2017 14:05 Dateiordner
| || 20.04. DPS-view-Edit Projekt.dps 20.04.2017 14:05 DPS-Datei 2K8
|B| Aus Projekt DPS-view Objekte importieren und bearbeiten.dps 10.04.2017 13:32 DPS-Datei 14 KB
File name: 20,04, DPS-view-Edit Projekt.dps -~ [DPSfiles (.dps) -
[ Open 1v} [ Cancel ]

Image 4-19 Project - Import object list - From project (.dps file)

In the window "Open", select the project whose objects you want to import, and click "Open".

After importing the objects of another project, the system will output the new objects in the current
object list.

» see Section 4.1.2 "The Object list"
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4.6.3 Add new objects and edit object attributes

Object lists can be edited manually by adding new objects to it or editing the attributes of already
existing objects.

The function "Add new object" is opened as follows:

* via the menu bar: Object=> New...
e  orvia the toolbar: @},l
e viathe keyboard shortcut: Ctrl+F

:
|1 0036 34B-0001-02 |
1D type:

|BS

Object Info text [max. 64 char.)...

Image 4-20 Add new object

The function to edit the "Edit object attributes" can be opened as follows:
e viathe menu bar: Object—> Edit...

e  Orviathe toolbar: @ |

* viathe keyboard shortcut: Ctrl+D

“m Edit object attributes i x|

10:; WOk
|00:0F-BE12E41

ID-Type:
4P

Infao text:
IAF'-EI2: Production 1zt Floor

Object I [masx. 32 char]...

Image 4-21 Edit object attributes

Menu bar/ button Description
ID The ID is the identifier of an object, e.g. for a DECT Base Station: DECT-
ID + SLC no. + Port no., WLAN Access Point: MAC Address
[max. 32 characters]
ID- type The ID type specifies the type of the object, e.g. Base Station:
"BS", WLAN Access Point: AP
[max. 4 characters]
Info text Info string that describes the object.
[max. 64 characters]

Table 4-19 The fields in the user windows "Add new object" and "Edit object attributes’
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4.6.4 Delete objects

Note:
Before an object is deleted, DPS-view-Edit asks you if you really want to delete it. When you con-
firm the security prompt with " Yes", the system will immediately delete the object irrevocably.
When you answer with "No", DPS-view-Edit will immediately abort the process.

The function to delete an object can be opened as follows:

* via the menu bar: Object—> Delete
e  orvia the toolbar:
e viathe keyboard shortcut: Ctrl+H

4.6.5 Place objects

To place an object on a map, it must be marked in the object list and carry the status " Can be
placed". When this is the case, the object can be placed on the map through drag&drop.

Objects can be placed in the following ways:

e Place objects freely on a map

» see Section 4.6.5.1 "Place objects freely on a map"
e Place objects in an already existing polygon through drag&drop

» see Section 4.6.5.2 "Place objects in a polygon through drag&drop"
e Assign an object to a polygon

» see Section 4.6.5.3 "Assign an object to a polygon"
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4.6.5.1

®
®

Place objects freely on a map

Note:

During the drag&drop process, the system will output the positioning coordinates of the object in
the user window's status bar (lower left).

Note:

After you initially assign an object of a certain ID type to a visualization template, DPS-view-Edit
will suggest that template the next time you place an object with the same ID type.

Follow the below instructions to place an object freely on a map:

No. Task Window
1. | Choose the wanted objects from the object | The selected objects are highlighted in
list. blue.
& Select visualization template x|
4] | |
™ Apply to all chiscts
2. | Pull the selected objects to the polygon The system will now open the following
through drag&drop. user window to select a visualization tem-
plate. If more than one object is selected,
Note: As your mouse pointer moves over the | the additional option *Apply to all objects”
polygon, the polygon takes on a black frame | Will @lsO appear.
surrounding it. * yes (ticked)
The entry is applied to all objects.
e no (not ticked)
The system will repeat the entry re-
quest for all of the other objects until
you either confirm or all selected ob-
jects have been placed.
‘m Select visualization template x|
:
M - —— T
< | |
I™ &pply to all objects
Table 4-20 Place objects freely on map
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No.

Task

Window

3a.

When you select the visualization template of
the type:

e ‘"Image' or

e ‘"Image list'

Here, the icon for the visualization template
of the type "Image" is output in keeping with
the configured simulation value in per-
cent.

In contrast, the icon for the visualization
template of the type "Image" is output in
keeping with its static parameters.

18

3b. | When you select the visualization template of | Here, the polygon for visualization template
the type: of the type "Color spectrum polygon" is
e "Color spectrum polygon" or output in form of a square and in keeping
e "Polygon’ with the configured simulation value in
percent.
In contrast, a polygon for the visualization
template of the type "Polygon" s output in
form of a square in keeping with its static
parameters.
%_W’Y_STE_ ¥ 230
' ' ) EQE
=
T .514
+
Table 4-20 Place objects freely on map
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No. Task Window

3c. | When you select the visualization template of |Here, the Polygon for the visualization
the type: templates of the types "Color spectrum
e "Color spectrum polygon with im- polygon with image" and "Color spec-
age', trum polygon with list of images" is out-
put in form of a square in keeping with the
configured simulation value in percent.

In the same way, the icon for the visualiza-
tion templates of the types "Polygon with
list of images" and"Color spectrum poly-
gon with images list" is output in keeping
with the configured simulation value in
percent.

In contrast, the Images and Polygons for
the visualization templates of the types
"Polygon with image", "Polygon with list
of images" and"Color spectrum polygon
with image" are output in keeping with their
static parameters.

e "Color spectrum polygon with list of
images",

e "Polygon with list of images" or

e "Polygon with image"

230

ZGE
=

T

Table 4-20 Place objects freely on map
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46.52 Place objects in a polygon through drag&drop
Follow the below instructions to place an object on a polygon through drag&drop:
No. Task Window

1. | Draw a polygon. Every polygon that does not yet have an
> see Section 4.7 "Polygons" object assigned to it is marked blue.

2. | Go to the object list and pull the wanted ob- | The system will now open the user window
jects from the list to the polygon through to select a visualization template.
drag&drop.

Note: As your mouse pointer moves over the
polygon, the polygon takes on a black frame e
SUrrOUnding |t Color level polpgon with list of images 12
4 | |
™ &pply to all abjects:
3a. | When you select the visualization template of |For the visualization type "Polygon" and
the type: "Color spectrum polygon":
e "Polygon" or e  The polygon is shown in keeping with
e "Color spectrum polygon" the configured simulation value.
all . P o ]
A
Z=hal
m
== N
I
=
Table 4-21 Place objects in polygon through drag&drop
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4-46

No.

Task

Window

3b. | When you select the visualization template of
the type:

"Polygon with image”,

"Polygon with list of images”,

"Color spectrum polygon with image",
or

"Color spectrum polygon with list of
images"

For the visualization type "Color spectrum
polygon with image" and "Color spec-
trum polygon with list of images":

®  The polygon is shown in keeping with
the configured simulation value.

For the visualization type "Polygon with

image" and "Polygon with list of images":

e Also the polygon is shown in keeping
with the configured simulation value.

===
| R

3c. | When you select the visualization template of

For the visualization type "Image" or "Im-

the type: age list":
e ‘"Image' or ® Theimage is shown in keeping with
e 'Image list" the configured simulation value.
e The polygon is retained as a non-as-
signed object.
Table 4-21 Place objects in polygon through drag&drop
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4.6.5.3

The function "Assign object" is opened as follows:

Assign an object to a polygon

Ctrl+A

via the menu bar: Tools=> Polygon—> Assign object...
via the keyboard shortcut:

Follow the below instructions to place an object on a polygon:

No. Task Window
1. | Draw a polygon. Every polygon that does not yet have an
» see Section 4.7 "Polygons" object assigned to it is marked blue.
2. |If needed, edit the polygon. With DPS-view-Edit you can edit polygons.
Via the menu bar:
Tools=> Polygon—> Edit
Via the shortcut:
CTRL+P
3. | To add an object to a polygon, make a mouse | This will mark the polygon to which you
click on the polygon. want to assign an object.
4. | Assign the wanted object(s) to the polygon. | This will open the list of all placeable ob-
Via the menu bar: jects that are available:
Tools=> Polygon—> Assign object. .. ' Assion obecttopolvaon i
Via the shortcut:
WalDSTR 54 Waldstrasse
CTRL+A e | K|
00:0F-BB1ZER:GA AP AP-01: Lounge
00:0F:BB12EA1S AP AP-02: Production 1st Flaar
O0:0F:BELTZEATS AP AP-02: Production 1st Floor
O0:0F:BELTZEANA AP AP-02: Production 1st Floor
0:0F:BB1ZED:28 AP AP-03: Accounting
OXOFBBIZED:Z9 AP AP-03 Accounting
OOOFBBIZED:Z28 AP AP-03 Accounting
OXOF:BEIZECDE AP AP-04: R&D 13t Floor
OXOF:BEIT:CHSs AP AP-10: Conf. Room 2nd Floor
List of abjects...
Table 4-22 Assign object to polygon
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4-48

No. Task Window
5. | From the list of placeable objects, select all | The system will now open the user window
objects you want to place. to select a visualization template.
= isualization template x|
n | 7O
Wi e e B ]
B | =
I #pply to all chiects
6a. | When you select the visualization template of | The polygon is output in keeping with your
the type: configured simulation value (for the visual-
e '"Polygon" or ization template of the type "Color spectrum
e "Color spectrum polygon". polygon’).
sl
S
:Sﬂ:
6b. | When you select the visualization template of | The polygon (for "Color spectrum poly-
the type: gon with image" and "Color spectrum
e 'Polygon with image", polygon with list of images") and the im-
e "Polygon with list of images”, age (fqr "PF"VQO.” with ir”nages" and“Fon—
e "Color soectrum polvaon with image®. | 90" with list of images") are output in
or P Polyg g keeping with the configured simulation
) o value in percent.
. Color spectrum polygon with list of
T.I . F b
I F*
ok s
I =
=
6¢c. | When you select the visualization template of | The image (for visualization type "Image
the type: list") is shown in keeping with the config-
e 'Image" or ured simulation value in percent.
e 'Image list" The polygon is retained as a non-assigned
object.
Table 4-22 Assign object to polygon

P31003-S1750-M103-01-76A9, 08/2021

OSCcAR Positioning System-view, Administrator Manual




The Administrator Tool DPS-view-Edit

Objects

4.6.6

Change the order of objects (Z-Level)

A\

Caution!

Bear in mind that the Z-Level is only relevant in DPS-view-Edit when editing objects. It has no
influence on the way in which the positioning results later appear in DPS-view.

As soon as DPS-view is in operation, the objects are shown according to the field strength with

which they are received, with the Base Station or Access Point that is received the strongest al-
ways shown at the top.

®
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Objects are placed individually on the map and arranged in the Z-level in keeping with the chrono-
logical order of their placement process.

» see lmage 4-22

Note:

When new objects are placed at a later point in time they may overlap and hide those that were
placed on the map before.

AZ Y.

'BS 4

MAPE,

BS 2

X
-

Image 4-22 Graphic representation of the Z-level: Placement of objects

The order of placed objects can be modified by changing their position in the Z-Level:

Via the menu item or shortcut

Edit > Sequence—> Bring to top (Ctrl+ Home)

Edit > Sequence—> Move up (Ctrl + Page up)
Edit > Sequence—> Move down (Ctrl + Page down)
Edit > Sequence—> Move to end (

Ctrl + End)
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Polygons
4.7 Polygons
Caution!

A Bear in mind that a polygon must have at least three but cannot have more than 20 polygon
points. If less than three points are drawn, DPS-view-Edit will automatically delete the polygon
after the double-click.

4.71 Add a new polygon
The function to create a new polygon is opened as follows:
e viathe menu bar: Tools=> Polygon—> New
®  or via the toolbar: Jﬁl
e viathe keyboard shortcut: Ctrl+L
The drawing of a polygon always begins with the first click of your mouse. From then on, every
next mouse click adds another point to the polygon. The drawing process ends with a double click.
The polygon is closed by connecting the last polygon point with the first.
The below image demonstrates how a polygon is drawn:
" it g 3N
8 |
s T Sl
5th mouse click doubleclick
Image 4-23 Draw new polygon
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4.7.2 Edit polygon points

Note:
@ Once you mark this menu item you can shift the points of the marked polygon.

The function to edit the polygon points is opened as follows:

e viathe menu bar: Tools=> Polygon—> Edit
e viathe keyboard shortcut: Ctrl+P

4.7.2.1 Add points to a polygon

Note:

You can customize the line-sensitivity of the mouse pointer to define when the pointer turns into
crosshairs.

» see Section 4.2 "Local parameters"

Follow the below instructions to add new points to a polygon:

e Activate the context menu "Add point" (shortcut: Ctr1+J)

e To do so, move your mouse pointer over the polygon line to which you want to add a new
point until the pointer changes into the crosshairs.

e  Make a right mouse click at the spot where you want to add a new point to the polygon.
e The new point will now be added to the polygon.

47.2.2 Delete points from a polygon

Note:

@ Use this function to delete marked polygon points.

The function to delete points from a polygon is opened as follows:

e viathe menu bar: Tools=> Polygon—> Delete point
e orvia the toolbar: Jﬁl
e viathe keyboard shortcut: Alt+Delete

4.7.2.3 Copy a polygon

Note:
@ With this function you can copy a polygon to the clipboard.

The function to copy a polygon is opened as follows:

e viathe menu bar: Tools=> Polygon—> Copy
e  or via the toolbar: “&‘.i.l
e viathe keyboard shortcut: Ctrl+cC
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4.7.2.4 Cut a polygon

Note:
@ This function can be used to cut a polygon and copy it to the clipboard.

The function to cut a polygon is opened as follows:

e viathe menu bar: Tools=> Polygon—> Cut
e orvia the toolbar: églnl
e viathe keyboard shortcut: Ctrl+x

47.25 Paste a polygon

Note:
@ With this function, polygons can be pasted from the clipboard.

The function to copy a polygon is opened as follows:

e viathe menu bar: Tools=> Polygon—> Paste
e or via the toolbar: ﬁnl
e viathe keyboard shortcut: Ctrl+v

4726 Delete a polygon

Note:

@ With this function polygons can be deleted altogether.

The function to delete a polygon is opened as follows:

e viathe menu bar: Tools=> Polygon—> Delete
e orvia the toolbar: ..i:-l
* viathe keyboard shortcut: Ctrl+Delete
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5 The Server Application DPS-view

Overview

This chapter covers the functions of the server application DPS-view, including the settings and

the logging of the positioning processes in the logfile and in the window of the application.

Contents
The chapter covers the following sections:

51 The system operation

5.2  The application start and the main window

5.8  Configuration of the server application via DPS-view-Config
54 Logging in a file and in the program window
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The system operation

5.1

5-2

The system operation

The server application DPS-view operates similar to a WEB server. Here, the HTML positioning
requests from OScAR-TT Operator-Tool are addressed to a TCP/IP Port (configurable, default:
Port 80). The positioning requests are answered by DPS-view with HTML pages, with the wanted
positioning details shown via OScAR-TT Operator-Tool.

The visualization process follows this routine:

Show waiting page

The HTML positing request from OScAR-TT Operator-Tool lasts a few seconds. During this
time, DPS-view outputs a so-called wait page, including details on the current positioning re-
quest.

Create session

The purpose of a session is to minimize the data traffic during the navigation between the
OSCcAR-TT Operator-Tool and DPS-view. To do so, the positioning details are transmitted in
encrypted form when the session is created. Once the session has been created, DPS-view
sends back the Session ID to OScAR-TT Operator-Tool. The session data is deleted after a
configurable timeout.

During a session, the following information is deposited:
—  the time when the session is created

—  the positioning details

—  the HTML map that was used last

Update a session (refresh)

Once a Session ID is available, the session's positioning details can be overwritten. This
function is applied in cyclical location tracking processes. In contrast, all other session-spe-
cific details such as but not limited to the navigation data is maintained.

Show map

OScAR-TT Operator-Tool can request a map from the server application DPS-view. Upon
the initial request, this map is shown at the top level. It ensures that when the positioning de-
tails are refreshed or updated, DPS-view always shows the map that the user last saw last.
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52 The application start and the main window
Note:
We recommend you install the server application DPS-view as a service.
Caution!
After the start of the DPS-view server application, the main window "DPS-view" will not automat-
ically open:
The main window "DPS-view" will only open after you start the DPS-view server application man-
ually:
All requests and replies thereto are logged in the main window of the DPS-view server application.
The administration of the server application DPS-view is carried out via the "DPS-view-Con-
fig.exe".
» see Section 5.3 "Configuration of the server application via DPS-view-Config'
Example of the main window of the server application DPS-view:

Corsven -l
21.09.2007 09:56:32 DPS—view V2.00a d
21.09.2007 09:56:32 WARNING: APP: Ho entries in vwhitelist!

21.09. 2007 09:56:32 APP: Initializing sessionhandler. . .
21.09. 2007 09:56:32 HHD: Initializing template=s. . .
21.09. 2007 09:56:32 HHD: Loading templates from: 'C:~Dokumente und Elnstellungen\Raupach\DesktD
21.09 2007 09:56:32 WARNINHG: HHND: Failure to load template 'Details. tpl . Using default templat
21.09 2007 09:56:32 WARNIHG: HWD: Failure to load template 'Error.tpl'. Using default template.
21.09 2007 09:56:32 WARNING: HHD: Failure to load template 'Header. tpl'. Using default template
21.09 2007 09:56:32 WARNING: HND: Failure to load template 'Info.tpl'. Using default template.
21.09 2007 09:56:32 WARNINHG: HHD: Failure to load template 'Location.tpl'. Using default templa
21.09. 2007 09:56:32 WARNINHG: HHD: Failure to load template 'Hap.tpl'. Using default template.
21.09 2007 09:56:32 WARNINHG: HHD: Failure to load template 'Nawvigation.tpl'. Using default temp
21.09 2007 09:56:32 WARNINHG: HHD: Failure to load template 'HapForm. tpl'. Using default templat
21.09 2007 09:56:32 WARNING: HHD: Failure to load template 'InputForm.tpl'. Using default templ
21.09 2007 09:56:32 HHD: Ses=ion path: 'C:nDokumente und Einstel lungen~Raupach*Desktop~Sessions
21.09 2007 09:56:32 HHND: Inititalizing maps .
21.09. 2007 09:56:32 EML: Loading file i
21.09 2007 09:56:32 EFROR: XML Parsing error in line=0 Position=0: Fal=scher Paramster.
21.09.2007 09:56:32 ERROR: ¥ML: Failure to load file ''!
21.09 2007 09:56:32 EFROR: HHD» Failure to initialize maps!
21.09 2007 09:56:32 WARNINHG: APP: DPS-wiew i= not initialized properlvl Ho queries will be answ
21.09 2007 09:56:32 APP:> Reinitializing server socket (port:80)
21.09 2007 09:56:32 APP: Application interface port 80 QK
i
Image 5-1  Main window DPS-view - Example
Summary of the fields in the window of the server application DPS-view:
Menu bar/ button Description
? Opens the DPS-view '‘About' box.
» see lmage 5-2
Table 5-1 DPS-view
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About DPS-view : x|

DP8 bps.view

Yersion 2.00a

Coppright = 1994 - 2007, All rights reserved.

tetronik GrnbH

Silberbachstrazze 10

B5232 T aunuzstein
Germary
phone: +45 (0161 28 /963 -1

fanw: +15 (016128 /963-4139

e-hail: infoEtetronik. com
Internet: hittp: v, etronils. com

Angewandte Elekbronik und Hachrichtentechnik

o Clase

Mote:
cohventions and treaties.

The owner of the copyright has the excluzive rightz for thiz computer software program protected by international

Ay coping or manipulation of all or parts of this software program iz subject to action pursued under civil and
crimitial law and will be prozecuted to the full extent of the law.

tetronik. GmbH AEM does not take any responzibility nor liability arising from the usage of this software program.

Clozes the dialog...

Image 5-2

DPS-view 'About’ box - Example
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5.3 Configuration of the server application via DPS-view-Config

The settings for the server application DPS-view are made in the program "DPS-view-Config"

Application interface

|F part: Timeout in zeconds;
a0an B0
IP wihitelist
I e
Paozitioning

Path ta map stucture
|E:'\tetmnik"~D PS-viewhE ditarsProjekt-tetranik -enE MAD PS -view-E dit. dpz

Path to HTML-templates:
]E:Htetmnik'\D PS-viewhSererh,

Timeout for positioning zession in minukes;
| 1

Loagging ta file
Path ta logoing directony:
|I::"'.tetn:unik"-.D PS-viewhServeriLogh

Lewvel
| Mormal j

Semer sernvice

Uninztall Stop

Languange: 1 Englizh j Ok Canicel

Image 5-3  DPS-view-Config - Options
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5-6

Summary of the fields in the window 'DPS-view Settings:

Menu bar/ button

Description

The window area "Application interface"

IP port

Enter here the TCP/IP port to which the applications ad-
dress the visualization requests.

(80]

Timeout in seconds

Enter here the timeout in seconds after which the port is
automatically closed by the server, even if the request has
not yet been completely received.

[60 s]

The window area 'IP whitelist'

IP whitelist

This is the list of all IP addresses that may be used by PCs
to connect to DPS-view. If no entries are made in this list,
all PCs may connect to DPS-view without restriction.

New Click this button to open a dialog and add a new IP ad-
dress to the IP whitelist.
x|
| 192 . 13 . 1w .
ok | ibbrechen |
Edit Click this button to open the following dialog to edit an IP
address.
|
| 192 . 183 . 10 . A
[k I Abbrechen |
Delete Click this button to delete marked entries from the IP wh-

itelist.

The window area "Positioning"

Path to map structure

Enter here the path to the hierarchical tree that contains
all maps, including their objects and parameterization.

Path for HTML templates

Enter here the path of the HTML templates that constitute
the groundwork for the creation of HTML map renditions.

Timeout for positioning session in

minutes

Enter here the timeout after which all session-specific in-
formation is deleted.

Table 5-2

Options - DPS-view Options
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Menu bar/ button

Description

Window area "Logging in the Terminal window"

Level

e 'Disabled
e 'Minimum

No protocoling

Data set ready

Inquiries from clients
Answers to clients

same as Minimum

+ detailed activation reporting
+ details on the

drawn objects

Same as Normal

+ output of of all raw data of the
protocol between client and
server (debugging mode).

e Normal

e 'Maximum'

Font

This is the font that is used by the system when logging in
this window. Click the box next to this field to open the win-

EOE 21|
Font: Font style:
ITahoma Iﬁ 0k I
Regular
Temninal |talic Eemer] |
(} Times New Foman
(} Trebuchet M3 Biold [talic
Tunga o
(} Werdana
(} WwWehdings |
— Sample
I AaBbYyZz
Script:

dow to select the font:

Window area "Logging in file"

Path to logging directory

Enter here the path where the lodfiles are written.

Level

Same as 'Level' in the window area "Logging in the Termi-
nal window".

Window area "Server service'

Install Installs DPS-view as a Windows service.
Uninstall Removes the DPS-view Server service.
Start Starts the currently inactive DPS-view Server service.
Stop Ends the currently active DPS-view Server service.
Language Language available:

e German

e English
Table 5-2 Options - DPS-view Options
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5.4

5-8

Logging in afile and in the program window
Depending in the settings, the system activities of DPS-view are logged in the program window
and/or written in a lodfile.

» see Section 5.3 "Configuration of the server application via DPS-view-Config"

Provided you select at least a minimum logging to a file, DPS-view will write a separate lodfile fro
each day. This lodfile contains details on the received visualization requests, ranging from the
maps that were requested to the objects that were output by the system.

The entries in this logfile have the following structure:
<dd>.<mm>.<yyyy> <HH>}<MM><SS><Status><Source>: <Message>

These entries make it possible for the user to trace the visualization requests that were received
and to analyze possible errors, e.g. misconfigured paths, missing Base Stations in the structure
etc.

Lodfiles are created in the following path:
<Path>\Server\Log.
The logfile names are in the following format:

<yyyy>-<mm>-<dd> <HH>-<MM>-<SS> DPS-view.log

Example of a valid lodfile path:
C:\tetronik\DPS-view\Server\Log\2007-01-25 00-05-12 DPS-view.log

The below table itemizes and explains the placeholders that are used in the messages that
are output in the program window and in the logfiles, and in the logfile names:

Placeholder Description

<dd> Day
<mm> Month
<yyyy> Year
<HH> Hour
<MM> minute

<SS> second
<Status> e without status Output of an info message

e  WARNING Output of a warning

e ERROR Output of an failure of system
error

<Source> e APP Application messages, e.g. re-
garding the connection, initial-
ization etc.

e HND Messages in connection with
the processing of positioning in-
formation

e XML Messages in connection with
the parsing of XML data

e DPS Messages in connection with
the setup of maps and HTML
pages

<Message> Message in plaintext
<Path> The installation path of DPS-view
Table 5-3 Summary of the placeholders used in file names and lodfile entries
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The below image stands as an example of the possible contents of a DPS-view lodfile.

All entries included in this file are itemized with the date and time, and listed in the correct chrono-
logical order with the newest entries at the end of the lodfile.

KA AR AR AR A A A A A A A A A A A A A A A A A A A A A A A AR A AR A AR AR A AR A AR AR A AR A A A AR AR A A A A A A A kA Ak A Ak Ak k%

LogFile initialized: 07.10.2005, 15.27.02

KA A A AR A A A A A A A A A A A A A A A A AR AR A A A A AR A A A A A A A A AR A A A A IR AR AR A A A A A A A ARk A kA A A A,k K

07.10.2005, 15.27.02: Applicationinterface Port 80: Start listening
07.10.2005, 15.27.54: 192.168.6.23:2138 -> accept incoming connection request
07.10.2005, 15.27.54: 192.168.6.23:2138 -> incoming data
#GET /GetSession.htm HTTP/1.1
#User-Agent: PNEZ
#Host: 192.168.6.23
#Cache-Control: no-cache
#
07.10.2005, 15.27.54: Infos: /GetSession.htm
07.10.2005, 15.27.54: 192.168.6.23:2138 -> Incoming 'GET'-Request: (/GetSes-
sion)
07.10.2005, 15.27.54: 192.168.6.23:2138 -> 'GET'-Request data
07.10.2005, 15.27.54: 192.168.6.23:2138 -> parsed 'GET'-Request data
07.10.2005, 15.27.54: Prepare all Pages
07.10.2005, 15.27.54: 192.168.6.23:2138 -> GET-Request answered (/GetSes-
sion.ht)
07.10.2005, 15.27.59: 192.168.6.23:2140 -> accept incoming connection request
07.10.2005, 15.27.59: 192.168.6.23:2140 -> incoming data
#GET /UserManagement/GetMap.htm?BsVal=0568594377e3619c98f5c4d5b322a47£7al17
#Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, application/
#Accept-Language: de
#Accept-Encoding: gzip, deflate
#User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; SV1; .NET
#Host: 192.168.6.23
#Connection: Keep-Alive
#
07.10.2005, 15.27.59: Infos: /UserManagement/GetMap.htm?BsVal=0568594377e3619c¢c
07.10.2005, 15.27.59: 192.168.6.23:2140 -> Incoming 'GET'-Request: (/UserManag
07.10.2005, 15.27.59: 192.168.6.23:2140 -> 'GET'-Request data
07.10.2005, 15.27.59: 192.168.6.23:2140 -> parsed 'GET'-Request data
07.10.2005, 15.27.59: Prepare all Pages
07.10.2005, 15.27.59: Delete old files
07.10.2005, 15.27.59: Parameter from HTML
07.10.2005, 15.27.59: Prepare the Map
07.10.2005, 15.27.59: Paint BS and Edit Imagemaps
07.10.2005, 15.27.59: Application 192.168.6.23:2140 -> Try to paint BS= 1009B3
07.10.2005, 15.27.59: Application 192.168.6.23:2140 -> Try to paint BS= 1009B3
07.10.2005, 15.27.59: Application 192.168.6.23:2140 -> Try to paint BS= 1009B3
07.10.2005, 15.27.59: Application 192.168.6.23:2140 -> Try to paint BS= 1009B3
07.10.2005, 15.27.59: Create JPGmap
07.10.2005, 15.27.59: Prepare the Subpages
07.10.2005, 15.27.59: Pages Created.

Table 5-4 Example of a DPS-view lodfile
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Glossary

The Glossary lists and explains in alphabetical order the technical terms that are found in this doc-

ument.

Term

Definition

Area of Interest

This is the terrain that is visually output on a map in DPS-view as the
result of the positioning of a DECT or WLAN terminal to specify the area
in which the wanted handset is currently located.

DECT Short for Digital Enhanced Cordless Telecommunications. DECT
stands for digital and enhanced cordless telecommunication. This is a
standard for cordless handsets and cell phones as well as for wireless
data transfer in general.

EPE Short for the Ekahau positioning server for cellular networks (WLAN),

"Ekahau Positioning Engine"

Field strength table

Thisis the table with the base stations/ac-cess points and their matching
field strength values, administrated internally by the terminals (DECT,
WLAN).

Gigaset Name of the Siemens AG for the product series of cordless handsets
that are based on the DECT standard.
HPS Short for the Siemens positioning server for cellular networks (DECT,

WLAN), or: HiPath Positioning System.

Emergency Call Re-
sponse Center (short:
PNEZ)

This is the center where emergency or distress calls from emergency
terminals (PNG, PNG-S) are received and processed. The short for
Emergency Call Response Centers with voice communication is:
PNEZ-S.

Emergency call hand-
sets (PNG, PNG-S)

These are cordless signal emitting terminals carried by exposed corpo-
rate persons or lone workers that are able to raise personal will-depen-
dent and/or will-independent alarms in the case of an emergency at the
Emergency Response Call Center (short: PNEZ).

The short for emergency handsets with voice is: PNG-S.*

SPS-Locator

A component of the Siemens HPS that visualizes received positioning
results for DECT and WLAN terminals on gauged maps in form of a cir-
cle in the Browser.

Visited Station

The DECT base station that is currently being used by the DECT hand-
set to communicate.

WLAN

Short for Wireless Local Area Network (WLAN), i.e. a "cordless" local
radio network in keeping with the standards of the IEEE 802.11-group.

Table 6-1

Glossary

*.Source: Regulation of the German Employer's Liability Insurance (Berufsgenossenschaften) for health and safety at
work, short: BGR-139, on the operation of emergency call response systems, HVBG, Hauptverband der gewerblichen

Berufsgenossenschaften; 2004
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